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Magellan Professional Products - Limited Warranty (North, 

Central and South America)

Magellan Navigation warrants their GPS receivers and hard-
ware accessories to be free of defects in material and work-
manship and will conform to our published specifications for 
the product for a period of one year from the date of original 
purchase. THIS WARRANTY APPLIES ONLY TO THE ORIGI-
NAL PURCHASER OF THIS PRODUCT. 

In the event of a defect, Magellan Navigation will, at its op-
tion, repair or replace the hardware product with no charge to 
the purchaser for parts or labor. The repaired or replaced prod-
uct will be warranted for 90 days from the date of return ship-
ment, or for the balance of the original warranty, whichever is 
longer. Magellan Navigation warrants that software products or 
software included in hardware products will be free from de-
fects in the media for a period of 30 days from the date of 
shipment and will substantially conform to the then-current 
user documentation provided with the software (including up-
dates thereto). Magellan Navigation's sole obligation shall be 
the correction or replacement of the media or the software so 
that it will substantially conform to the then- current user doc-
umentation. Magellan Navigation does not warrant the soft-
ware will meet purchaser's requirements or that its operation 
will be uninterrupted, error-free or virus-free. Purchaser as-
sumes the entire risk of using the software.

PURCHASER'S EXCLUSIVE REMEDY UNDER THIS WRIT-
TEN WARRANTY OR ANY IMPLIED WARRANTY SHALL BE 
LIMITED TO THE REPAIR OR REPLACEMENT, AT MAGEL-
LAN NAVIGATION'S OPTION, OF ANY DEFECTIVE PART OF 
THE RECEIVER OR ACCESSORIES WHICH ARE COVERED 
BY THIS WARRANTY. REPAIRS UNDER THIS WARRANTY 
SHALL ONLY BE MADE AT AN AUTHORIZED MAGELLAN 
NAVIGATION SERVICE CENTER. ANY REPAIRS BY A SER-
VICE CENTER NOT AUTHORIZED BY MAGELLAN NAVIGA-
TION WILL VOID THIS WARRANTY.

To obtain warranty service the purchaser must obtain a Return 
Materials Authorization (RMA) number prior to shipping by 
calling 1-800-229-2400 (press option #1) (U.S.) or 1-408-
615-3981 (International), or by submitting a repair request 
on-line at: 
http://professional.magellangps.com/en/support/rma.asp. The 
purchaser must return the product postpaid with a copy of the 
original sales receipt to the address provided by Magellan Nav-
igation with the RMA number. Purchaser’s return address and 
the RMA number must be clearly printed on the outside of the 
package.

Magellan Navigation reserves the right to refuse to provide ser-
vice free-of-charge if the sales receipt is not provided or if the 
information contained in it is incomplete or illegible or if the 
serial number is altered or removed. Magellan Navigation will 
not be responsible for any losses or damage to the product in-
curred while the product is in transit or is being shipped for 
repair. Insurance is recommended. Magellan Navigation sug-
gests using a trackable shipping method such as UPS or Fe-
dEx when returning a product for service.

EXCEPT AS SET FORTH IN THIS LIMITED WARRANTY, ALL 
OTHER EXPRESSED OR IMPLIED WARRANTIES, INCLUD-
ING THOSE OF FITNESS FOR ANY PARTICULAR PURPOSE, 
MERCHANTABILITY OR NON-INFRINGEMENT, ARE HERE-
BY DISCLAIMED AND IF APPLICABLE, IMPLIED WARRAN-
TIES UNDER ARTICLE 35 OF THE UNITED NATIONS 
CONVENTION ON CONTRACTS FOR THE INTERNATIONAL 
SALE OF GOODS. Some national, state, or local laws do not 

allow limitations on implied warranty or how long an implied 
warranty lasts, so the above limitation may not apply to you.

The following are excluded from the warranty coverage: (1) pe-
riodic maintenance and repair or replacement of parts due to 
normal wear and tear; (2) batteries and finishes; (3) installa-
tions or defects resulting from installation; (4) any damage 
caused by (i) shipping, misuse, abuse, negligence, tampering, 
or improper use; (ii) disasters such as fire, flood, wind, and 
lightning; (iii) unauthorized attachments or modification; (5) 
service performed or attempted by anyone other than an au-
thorized Magellan Navigations Service Center; (6) any prod-
uct, components or parts not manufactured by Magellan 
Navigation; (7) that the receiver will be free from any claim for 
infringement of any patent, trademark, copyright or other pro-
prietary right, including trade secrets; and (8) any damage due 
to accident, resulting from inaccurate satellite transmissions. 
Inaccurate transmissions can occur due to changes in the po-
sition, health or geometry of a satellite or modifications to the 
receiver that may be required due to any change in the GPS. 
(Note: Magellan Navigation GPS receivers use GPS or 
GPS+GLONASS to obtain position, velocity and time informa-
tion. GPS is operated by the U.S. Government and GLONASS 
is the Global Navigation Satellite System of the Russian Fed-
eration, which are solely responsible for the accuracy and 
maintenance of their systems. Certain conditions can cause 
inaccuracies which could require modifications to the receiv-
er. Examples of such conditions include but are not limited to 
changes in the GPS or GLONASS transmission.)  Opening, dis-
mantling or repairing of this product by anyone other than an 
authorized Magellan Navigation Service Center will void this 
warranty.

MAGELLAN NAVIGATION SHALL NOT BE LIABLE TO PUR-
CHASER OR ANY OTHER PERSON FOR ANY INCIDENTAL 
OR CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUD-
ING BUT NOT LIMITED TO LOST PROFITS, DAMAGES RE-
SULTING FROM DELAY OR LOSS OF USE, LOSS OF OR 
DAMAGES ARISING OUT OF BREACH OF THIS WARRANTY 
OR ANY IMPLIED WARRANTY EVEN THOUGH CAUSED BY 
NEGLIGENCE OR OTHER FAULT OFMAGELLAN NAVIGATION 
OR NEGLIGENT USAGE OF THE PRODUCT. IN NO EVENT 
WILL MAGELLAN NAVIGATION BE RESPONSIBLE FOR 
SUCH DAMAGES, EVEN IF MAGELLAN NAVIGATION HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

This written warranty is the complete, final and exclusive 
agreement between Magellan Navigation and the purchaser 
with respect to the quality of performance of the goods and 
any and all warranties and representations. This warranty sets 
forth all of Magellan Navigation's responsibilities regarding 
this product. This limited warranty is governed by the laws of 
the State of California, without reference to its conflict of law 
provisions or the U.N. Convention on Contracts for the Inter-
national Sale of Goods, and shall benefit Magellan Navigation, 
its successors and assigns.

This warranty gives the purchaser specific rights. The purchas-
er may have other rights which vary from locality to locality (in-
cluding Directive 1999/44/EC in the EC Member States) and 
certain limitations contained in this warranty, including the 
exclusion or limitation of incidental or consequential damages 
may not apply. 

For further information concerning this limited warranty, 
please call or write:

Magellan Navigation, Inc., El Camino Real 451, Suite 210, 
CA 95050, Santa Clara, USA, Phone: +1 408 572 1100
Fax: +1 408 572 1199 or

Magellan Navigation SAS - ZAC La Fleuriaye - BP 433 - 44474 
Carquefou Cedex - France  Phone: +33 (0)2 28 09 38 00, 
Fax: +33 (0)2 28 09 39 39.



Magellan Professional Products Limited Warranty (Europe, 

Middle East, Africa)

All Magellan Navigation global positioning system (GPS) re-
ceivers are navigation aids, and are not intended to replace 
other methods of navigation. Purchaser is advised to perform 
careful position charting and use good judgment. READ THE 
USER GUIDE CAREFULLY BEFORE USING THE PRODUCT.

1. MAGELLAN NAVIGATION WARRANTY

Magellan Navigation warrants their GPS receivers and hard-
ware accessories to be free of defects in material and work-
manship and will conform to our published specifications for 
the product for a period of one year from the date of original 
purchase or such longer period as required by law. THIS WAR-
RANTY APPLIES ONLY TO THE ORIGINAL PURCHASER OF 
THIS PRODUCT. 

In the event of a defect, Magellan Navigation will, at its op-
tion, repair or replace the hardware product with no charge to 
the purchaser for parts or labor. The repaired or replaced prod-
uct will be warranted for 90 days from the date of return ship-
ment, or for the balance of the original warranty, whichever is 
longer. Magellan Navigation warrants that software products or 
software included in hardware products will be free from de-
fects in the media for a period of 30 days from the date of 
shipment and will substantially conform to the then-current 
user documentation provided with the software (including up-
dates thereto). Magellan Navigation's sole obligation shall be 
the correction or replacement of the media or the software so 
that it will substantially conform to the then- current user doc-
umentation. Magellan Navigation does not warrant the soft-
ware will meet purchaser's requirements or that its operation 
will be uninterrupted, error-free or virus-free. Purchaser as-
sumes the entire risk of using the software.

2. PURCHASER'S REMEDY

PURCHASER'S EXCLUSIVE REMEDY UNDER THIS WRIT-
TEN WARRANTY OR ANY IMPLIED WARRANTY SHALL BE 
LIMITED TO THE REPAIR OR REPLACEMENT, AT MAGEL-
LAN NAVIGATION'S OPTION, OF ANY DEFECTIVE PART OF 
THE RECEIVER OR ACCESSORIES WHICH ARE COVERED 
BY THIS WARRANTY. REPAIRS UNDER THIS WARRANTY 
SHALL ONLY BE MADE AT AN AUTHORIZED MAGELLAN 
NAVIGATION SERVICE CENTER. ANY REPAIRS BY A SER-
VICE CENTER NOT AUTHORIZED BY MAGELLAN NAVIGA-
TION WILL VOID THIS WARRANTY.

3. PURCHASER'S DUTIES

To obtain service, contact and return the product with a copy 
of the original sales receipt to the dealer from whom you pur-
chased the product.

Magellan Navigation reserves the right to refuse to provide ser-
vice free-of-charge if the sales receipt is not provided or if the 
information contained in it is incomplete or illegible or if the 
serial number is altered or removed. Magellan Navigation will 
not be responsible for any losses or damage to the product in-
curred while the product is in transit or is being shipped for 
repair. Insurance is recommended. Magellan Navigation sug-
gests using a trackable shipping method such as UPS or Fe-
dEx when returning a product for service.

4. LIMITATION OF IMPLIED WARRANTIES

EXCEPT AS SET FORTH IN ITEM 1 ABOVE, ALL OTHER EX-
PRESSED OR IMPLIED WARRANTIES, INCLUDING THOSE 
OF FITNESS FOR ANY PARTICULAR PURPOSE OR MER-
CHANTABILITY, ARE HEREBY DISCLAIMED AND IF APPLI-
CABLE, IMPLIED WARRANTIES UNDER ARTICLE 35 OF THE 
UNITED NATIONS CONVENTION ON CONTRACTS FOR THE 
INTERNATIONAL SALE OF GOODS. 

Some national, state, or local laws do not allow limitations on 
implied warranty or how long an implied warranty lasts, so the 
above limitation may not apply to you.

5. EXCLUSIONS

The following are excluded from the warranty coverage: 

(1) periodic maintenance and repair or replacement of parts 
due to normal wear and tear; 

(2) batteries; 

(3) finishes; 

(4) installations or defects resulting from installation; 

(5) any damage caused by (i) shipping, misuse, abuse, negli-
gence, tampering, or improper use; (ii) disasters such as fire, 
flood, wind, and lightning; (iii) unauthorized attachments or 
modification; 

(6) service performed or attempted by anyone other than an 
authorized Magellan Navigations Service Center; 

(7) any product, components or parts not manufactured by 
Magellan Navigation, 

(8) that the receiver will be free from any claim for infringe-
ment of any patent, trademark, copyright or other proprietary 
right, including trade secrets 

(9) any damage due to accident, resulting from inaccurate sat-
ellite transmissions. Inaccurate transmissions can occur due 
to changes in the position, health or geometry of a satellite or 
modifications to the receiver that may be required due to any 
change in the GPS. (Note: Magellan Navigation GPS receivers 
use GPS or GPS+GLONASS to obtain position, velocity and 
time information. GPS is operated by the U.S. Government 
and GLONASS is the Global Navigation Satellite System of the 
Russian Federation, which are solely responsible for the accu-
racy and maintenance of their systems. Certain conditions can 
cause inaccuracies which could require modifications to the 
receiver. Examples of such conditions include but are not lim-
ited to changes in the GPS or GLONASS transmission.).

Opening, dismantling or repairing of this product by anyone 
other than an authorized Magellan Navigation Service Center 
will void this warranty.

6. EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAM-
AGES

MAGELLAN NAVIGATION SHALL NOT BE LIABLE TO PUR-
CHASER OR ANY OTHER PERSON FOR ANY INDIRECT, IN-
CIDENTAL OR CONSEQUENTIAL DAMAGES WHATSOEVER, 
INCLUDING BUT NOT LIMITED TO LOST PROFITS, DAMAG-
ES RESULTING FROM DELAY OR LOSS OF USE, LOSS OF 
OR DAMAGES ARISING OUT OF BREACH OF THIS WARRAN-
TY OR ANY IMPLIED WARRANTY EVEN THOUGH CAUSED 
BY NEGLIGENCE OR OTHER FAULT OFMAGELLAN NAVIGA-
TION OR NEGLIGENT USAGE OF THE PRODUCT. IN NO 
EVENT WILL MAGELLAN NAVIGATION BE RESPONSIBLE 
FOR SUCH DAMAGES, EVEN IF MAGELLAN NAVIGATION 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAM-
AGES.

Some national, state, or local laws do not allow the exclusion 
or limitation of incidental or consequential damages, so the 
above limitation or exclusion may not apply to you.

7. COMPLETE AGREEMENT

This written warranty is the complete, final and exclusive 
agreement between Magellan Navigation and the purchaser 
with respect to the quality of performance of the goods and 
any and all warranties and representations. THIS WARRANTY 
SETS FORTH ALL OF MAGELLAN NAVIGATION'S RESPONSI-
BILITIES REGARDING THIS PRODUCT. 

THIS WARRANTY GIVES YOU SPECIFIC RIGHTS. YOU MAY 
HAVE OTHER RIGHTS WHICH VARY FROM LOCALITY TO LO-
CALITY (including Directive 1999/44/EC in the EC Member 
States) AND CERTAIN LIMITATIONS CONTAINED IN THIS 
WARRANTY MAY NOT APPLY TO YOU.



8. CHOICE OF LAW.

This limited warranty is governed by the laws of France, with-
out reference to its conflict of law provisions or the U.N. Con-
vention on Contracts for the International Sale of Goods, and 
shall benefit Magellan Navigation, its successors and assigns.

THIS WARRANTY DOES NOT AFFECT THE CUSTOMER'S 
STATUTORY RIGHTS UNDER APPLICABLE LAWS IN FORCE 
IN THEIR LOCALITY, NOR THE CUSTOMER'S RIGHTS 
AGAINST THE DEALER ARISING FROM THEIR SALES/PUR-
CHASE CONTRACT (such as the guarantees in France for la-
tent defects in accordance with Article 1641 et seq of the 
French Civil Code).

For further information concerning this limited warranty, 
please call or write:

Magellan Navigation SAS - ZAC La Fleuriaye - BP 433 - 44474 
Carquefou Cedex - France.

Phone: +33 (0)2 28 09 38 00, Fax: +33 (0)2 28 09 39 39
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1. Installing Mobile Mapping

Installing Mobile Mapping on Mobile Mapper CX is a three-
step process:
1. Uploading Installation files from the Mobile Mapping CD 

to the MobileMapper CX through Microsoft ActiveSync.
2. Installing Mobile Mapping in MobileMapper CX. This step 

is automatically started in MobileMapper CX once all the 
installation files have been uploaded.

3. Unlocking Mobile Mapping by entering a product key in 
MobileMapper CX.

Installation Instructions

It is assumed that Microsoft ActiveSync is running on your of-
fice computer. ActiveSync can be installed using the installa-
tion files provided on the MobileMapper CX Companion CD.
It is also assumed that MobileMapper CX’s USB port has been 
set to “USB serial for ActiveSync”. See “Setting the Mini-USB 
Port” in your MobileMapper CX Getting Started Guide.
1. Attach the I/O module to the back of the MobileMapper CX 

unit.
2. Connect the MobileMapper CX to your office computer 

using the USB cable. The USB cable is plugged into 
MobileMapper CX’s I/O module.

3. Turn on MobileMapper CX.
4. Insert the Magellan MobileMapping CD into your CD drive 

of your office computer. Wait until the auto-run window 
opens on the computer screen. If the auto-run file fails to 
start automatically, browse the installation CD and run the 
Setup.exe file.

5.  Choose your language.
6. Click on the Install Mobile Mapping 1.3x with... option corre-

sponding to your area (US or European map).
7. Click OK when the Install “Magellan Mobile Mapping 1.3x” 

using the default application install directory message appears. 
This starts the installation. The message Installing Magellan 
Mobile Mapping 1.3x... is displayed while the installation 
files are transferred to the MobileMapper CX.
1
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8. At the end of the file transfer, the following message is 
displayed on the computer: Please check your mobile device 
screen to see if additional steps are necessary to complete this 
installation. Click OK to close this message box.
During this time, the MobileMapper CX has started install-
ing the software. A progress bar is displayed on the 
MobileMapper screen to indicate the different phases of 
the installation. The progress bar disappears when instal-
lation is complete. The MobileMapper CX workspace 
screen then shows the Mobile Mapping shortcut icon.

Unlocking Mobile Mapping

1. Double-tap the Mobile Mapping icon. This opens the Unlock 
MM Option screen.

2. Type the product key (a 13-character string) your Magellan 
dealer provided to you when you purchased the option.

3. Tap OK. A message indicates that Mobile Mapping was 
successfully unlocked.

4. Tap OK to close the message window.
5. Select the Mobile Mapping interface language from the 

list of available languages.
6. Press ENTER to accept the license agreement and to start 

using Mobile Mapping.



A feature library is a hierar-
chical structure that guides 
you through the description 

process so you know you 
will describe thoroughly 

and quickly each feature 
you visit. You will not have 

to remember what 
attributes of each feature 

you should record: the fea-
ture library will tell you!

Example of a “streetlight” 
point feature, as may be 

described in a feature 

library 

Feature libraries are cre-
ated using the Feature 

Library Editor module in 
MobileMapper Office.

Condition

# of bulbs

Closest

Address

List Attribute
valuesof streetlight 

- Good
- Needs repair
- Needs paint

Enter

Type in

numeric value

Street

address

attributes
2. Collecting GPS/GIS Data

Introduction to Feature Libraries

Feature libraries contain lists of features that you should be 
visiting during your field sessions.
Features are four types:
- Point feature: The geometrical representation of this fea-

ture is a point. Logging this type of feature requires static 
occupation at the point.

- Line feature: The geometrical representation of this fea-
ture is a line. Logging this type of feature requires that you 
move along this line.

- Area feature: The geometrical representation of this fea-
ture is an area. Logging this type of feature requires that 
you move along its contour.

- Grid feature: The geometrical representation of this fea-
ture is an array of evenly-distributed waypoints. Mobile 
Mapping will guide you to each of these waypoints where 
you should enter a measurement performed at this point.

Each feature also has a number of attributes. There are three 
categories of attributes:
- Menu style where the attribute values are words or phrases 

that you pick off a list (e.g. a list of values for the attribute 
Condition might include Good, Needs Repair, etc.; see 
opposite)

- Numeric style where you select a number within a speci-
fied range (e.g. the # of bulbs might be in the range 0 to 
3)

- Text style where you type in a note that can contain both 
numbers and letters (e.g. the closest street address)

You can upload as many feature libraries as you want into your 
unit. Just remember that you can use only one feature library 
for logging data to an individual job.
3
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Satellite Signal
Strength Chart:

Clear bars indicate that 
the unit is starting to 
get information from 
satellites. Solid bars 

indicate that the satel-
lites are being used to 

compute your position.

Satellite Position Graph:

The 2 circles indicate 
satellite elevation as 

seen from your current 
position. The outer cir-
cle represents the hori-
zon and the inner circle 

represents 45° from 
the horizon. The center 

of the circle is 90° 
from the horizon, or 

directly overhead.
Logging New GPS/GIS Data

1. Launching Mobile Mapping - Mobile Mapping Settings

Assuming the Mobile Mapping software has been installed as 
explained in Installing Mobile Mapping on page 1 and Mo-
bileMapper CX has been started according to the instructions 
in Preparing for first-time use in the MobileMapper CX Getting 
Started Guide, do the following:

1. Turn on MobileMapper CX by pressing the power button. 
The unit turns on, starts the boot sequence and then dis-
plays the workspace screen.

2. Take MobileMapper CX to a location where there is clear 
view of the sky.

3. Double-tap the Mobile Mapping shortcut icon. This starts 
Mobile Mapping. You should now see the satellite status 
screen. If not, press the NAV key until you see this screen 
(see below).
Watching the bars appear and turn solid on the screen, 
you can progressively see the unit lock onto satellites.

For best accuracy, it is important to hold the receiver at an 
angle of 45° from horizontal and not too close to you.

Satellite Position Graph

Battery Life Indicator

Satellite Signal 
Strength Chart

Satellite Positions in 
the Sky & Numbers 
(W for SBAS)

45°



While the unit is acquiring satellites, take a minute to famil-
iarize yourself with some of the Mobile Mapping setup func-
tions. Press the MENU key and select Setup.
There are many options to select among, and all are explained 
in full in the section entitled MENU key on page 44. For the 
purposes of getting started, however, we will concentrate on 
just a few.

Language
Mobile Mapping supports multiple languages. You can select 
the language you are most familiar with by using this option.

Coordinate system (Coord System)
Mobile Mapping can display your position in a variety of coor-
dinate systems, both geographic and grid systems. Unless you 
know which one you want to use, you can use the default 
choice (Lat/Lon) for the primary system. You can always trans-
form any data you collect in the field to the coordinate system 
used by your GIS when you get back to the office.

Map Datum
You can select the map datum you want to display your data 
in. As with the Coordinate System option, you can use the de-
fault choice (WGS 84) for the primary map datum while you 
are getting started.
Mobile Mapping can calculate and display your position on two differ-
ent map datums with each datum having its own coordinate system.

Nav Units
You use this option to set the units of measurement you want 
to use. The default for long distances, short distances, speed 
and area are kilometers, meters, kph and hectares. You can 
set this to miles, feet, mph, acres if you like or to three other 
standard sets of units. You can also create a custom mix of 
units by selecting the Advanced option that contains a wide va-
riety of units for distance, speed, elevation, bearing and area.
-

5
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Entering a job name

Note that Mobile Mapping 
includes a "Generic" library 

containing default fea-
tures. This library contains 
a point feature, a line fea-
ture, an area feature and a 
grid feature. Each of these 
features has a single text-

style attribute. Use this 
library only as a “backup” 

library.
4. Creating a Job and Selecting a Feature Library

- Press the LOG button
- Tap Create New Job. The screen displays the Job Name 

field in which you should enter the name of the new 
job. A keyboard is displayed underneath to let you 
enter this name.
To enter a name, tap on the corresponding letters on 
the keyboard.

- When you have finished entering the name, tap  on 
the on-screen keyboard or press the ENTER key. A new 
screen is then displayed listing the feature libraries 
stored in your unit. 

- Tap the name of the feature library you want to use. A 
new screen is then displayed asking you to choose the 
job mode:
• Real-time: If you select this job mode, the receiver 

will record only feature positions and descriptions 
and GPS metadata. Jobs recorded in real-time mode 
cannot be differentially corrected later on.

• Post-processing: Select this job mode to allow Mobile 
Mapping to record the job so that later on, it can be 
post-processed in MobileMapper Office. In this job 
mode, Mobile Mapping will record GPS measure-
ments files in addition to the MMJ job file that is 
recorded in real time. Warning! This job mode can 
only be used after entering an activation code. For 
more information, see Post-Processing Option on 
page 25.

- Tap one of these modes. The screen now lists all the 
features available from the selected feature library.



Mobile Mapping uses a 
fixed, time-based logging 
interval (1 second) when 

you log a point feature. The 
logging interval parameter 
cannot be accessed when 

you log a point feature. 

Logging screen

The Logging screen also 
displays the time elapsed 

since you started logging at 
this point feature, the 

number of satellites cur-
rently received and the cur-

rent value of PDOP.

If you start logging a new 
feature and you realize this 
is a mistake, then you can 

delete the new feature 
being logged by tapping 
the Options button and 

selecting Delete <feature 
name>.

Deleting features only 
applies to new features 

being logged, not to fea-
tures already logged.
5. Logging and Describing a Point Feature

- Choose the type of feature you want to log from this 
list. You can tell by the name of this feature whether it 
is a point feature, a line feature or an area feature.

- Tap a point feature (you are supposed to be near one of 
these features) and tap the on-screen Log button. This 
starts feature logging. A sound is heard every time 
Mobile Mapping logs data.
The Logging screen is now displayed where you can 
see the list of attributes pertaining to this feature. You 
will now enter the “Description” phase of the feature.

- Tap the first attribute and enter the right attribute 
value describing the feature near you. This takes you 
back to the Logging screen.

- Highlight the next attribute in the list and repeat the 
previous step. Repeat this step until all the attributes 
have been properly described.
“Describing” the feature only takes a few seconds. By 
the time you are done with the feature description, the 
feature’s GPS position will have been saved in the job. 
You can also stay more time on the feature to let the 
receiver determine several positions. This will give an 
even more accurate position for the feature as Mobile 
Mapping will average all the GPS positions it has com-
puted on the feature.

- To stop logging the feature, tap Done. This takes you 
back to the Feature List screen

- Move to the next feature and resume the above 
instructions to log this feature.
7
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Selecting the logging 

interval option
6. Logging and Describing a Line Feature

Basically, you use the same procedure as when you log a 
point feature (see 2. above). There are however two differ-
ences when you log a line feature:
- You need to define a logging interval when you start 

logging the feature
- And then you are supposed to move from the begin-

ning to the end of the line feature before stopping the 
logging.

These differences are explained below.
After tapping a line feature from the Feature List screen 
(for example a road) and tapping the Log button, Mobile 
Mapping starts logging GPS positions from the position 
where you are. The default logging interval is 5 seconds.
By decreasing the logging interval you can increase the 
level of detail in your maps. By increasing the logging 
interval, you can save memory. In general, you should set 
the logging interval to the smallest setting possible with-
out running out of memory. Remember you can take multi-
ple SD cards with you to the field. The only requirement is 
that you close the job file before replacing the SD card.

To change this interval:
- Tap Options on the screen and then Logging Interval.



The Logging screen also 
displays the distance trav-
eled since you started log-

ging the line feature, the 
number of satellites cur-

rently received and the cur-
rent value of PDOP.

Logging screen
Two options are then prompted:
By Time: Select this option when you want to log a new 
GPS position at regular intervals of time regardless of 
the distance traveled since the last position logged. 
After tapping this option, tap the desired time interval. 
This takes you back to the Logging screen where you 
can see the list of attributes pertaining to the feature.
By Distance: Select this option when you want to log a 
new GPS position only after you have moved by a cer-
tain distance since the last position logged. After tap-
ping this option, tap the desired distance interval. This 
takes you back to the Logging screen where you can 
see the list of attributes pertaining to the feature.

- As you would for a point feature, describe the feature 
by describing the different attributes pertaining to the 
feature

- When the description is finished, you can start walking 
along the line feature

- When you arrive at the end of the line feature, with 
your unit still displaying the Logging screen, tap Done 
to stop logging the feature.

The receiver determines the length of a line feature by 
estimating the distance between successive points on the 
line feature with the assumption that each point is on a 
sphere of average Earth radius. The elevations of the 
points are not factored into the equation. Thus the 
receiver calculates the spherical distance rather than the 
horizontal or slope distance between the successive posi-
tions.
9
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This screen displays the 
current values of perime-

ter and area measured 
since you started logging 
the feature (+ number of 

satellites and PDOP)

Logging screen
If you wish to change the logging interval while you are 
logging a line feature, do the following:
- Tap Options and then Logging Interval. Set the new log-

ging interval as explained above. The receiver will con-
tinue to log the feature, but this time according to the 
new logging interval.

7. Logging and Describing an Area Feature

Basically, you use the same procedure as when you log a 
line feature, especially regarding the need for defining a 
logging interval (see 4. above). The only difference 
between a line and area feature is that for an area feature, 
the first and last position calculated by the receiver are 
connected when you close the feature.

Record the attributes of an area feature as you do for a 
line feature (see page 8):
- Tap the name of the area feature from the list of fea-

tures and tap the Log button. Mobile Mapping starts 
logging the area feature.

- Choose a logging interval (see explanations given for a 
line area on page 8). This takes you back to the Log-
ging screen where the list of attributes for the feature 
is displayed

- Describe each attribute by selecting or entering the 
appropriate attribute value for each of them.



Selecting the Pause Park 
option
The receiver determines the perimeter of an area feature 
by estimating the distance between successive points on 
the line feature with the assumption that each point is on 
a sphere of average Earth radius. The elevations of the 
points are not factored into the equation. Thus the 
receiver calculates the spherical distance rather than the 
horizontal or slope distance between the successive posi-
tions. The perimeter of the area feature is the sum of all 
these distances. For the same reason, the measured area 
is that of a curved, not flat, feature.

8. Pausing a Feature

When you are recording lines or areas, it is sometimes 
impossible to walk or drive the entire length of the feature 
because of obstacles in your way such as fences, build-
ings, bodies of water, etc. When you must interrupt the 
recording of any feature (excluding point features), follow 
these steps:
- Tap Options and then Pause <feature name>. This pauses 

the logging of the feature.
- Move around the obstacle to the next accessible por-

tion of the feature
- To resume logging, tap Options and then Resume <fea-

ture name>. This resumes the logging.
- When you finish logging the feature, just tap Done.
11
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Selecting the Repeat 
Attributes option
9. Logging New Features with Same Attributes as Those Set 

in the Previously Logged Feature

If you close a point, line or area feature and want to log 
the location of another feature of the same type and with 
an identical description, use the Repeat Attributes function.
After closing a feature, Mobile Mapping takes you back to 
the Feature List screen on which the same feature type is 
still selected. Just do the following:
- Move to the next similar feature you want to log.
- Tap Log to start logging the new feature.
- Tap Options and then Repeat Attributes. As a result, all 

the attributes of the previously logged feature are 
immediately assigned to the feature been logged.

- After logging the GPS position(s) of this feature, tap 
Done to close the feature.

10.Nesting a Feature

When you are logging GPS positions to a feature, you may 
find another feature that you also want to log. Rather than 
log the entire feature and come back to record this other 
feature, you can simply pause the feature being logged, 
log the other feature, close it and resume logging the first 
feature.
Logging one feature while you have paused another fea-
ture is called “nesting.” You can nest any feature, point 
line or area, into any line or area feature. It is not possible 
to nest a point feature inside another point feature.
Nesting is particularly useful when you are mapping things 
such as a road with streetlights along the route or a shore-
line with stretches of erosion along it and the locations of 
certain habitats.



Assuming you are logging a line feature and the Logging 
screen is displayed, do the following, for example to nest a 
point feature:
- Tap Options and then Pause <feature name>. This pauses 

the logging of the line feature.
- Tap Options again and then Nest Feature
- Move to the location of the feature you want to nest
- In the Feature List screen now displayed, tap the fea-

ture type you want to nest.
- Tap Log to start logging this feature.
- Describe the attributes of the feature as explained 

above
- Tap Done when you have finished logging the nested 

feature.
- Tap Options and then Resume <feature name>. This takes 

you back to the Logging screen from which you can 
normally finish the logging of the line feature.

11.Offsetting a Point Feature

Sometimes the feature you want to put on the map is in 
area of poor GPS reception or is not accessible. This is 
when you can map the feature using the offset utility. By 
combining the receiver’s position with the bearing and dis-
tance to the feature, Mobile Mapping will automatically 
calculate and record the position of the feature.
To input an offset for a point feature, assuming the Fea-
ture List screen is now displayed, do the following:
- Tap one of the listed point features available from the 

selected feature library.
- Tap Log to start logging the feature
- Tap Options and then Offset.
13
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Point Offset screen

If you do not have a com-
pass, you can use the Com-

pass screen (see also 
page 30) to determine the 

bearing to the offset fea-
ture. If you have been mov-

ing for 5 to 10 seconds 
along a straight line, the 
Compass screen will tell 

you your bearing. You can 
use this to determine the 
bearing to the offset fea-

ture. CAUTION! The 
receiver cannot determine 
direction while stationary 

and the compass direction 
remains the same even if 

you rotate the receiver.

Visual estimation for horz. 
& vert. distances is usually 

good enough in terms of 
accuracy.
This displays the Point Offset screen on which you 
should enter the following parameters:
Bearing: Compass direction to the feature from your 
current position. You need a compass to measure this 
angle (see also opposite). To input a value for Bearing, 
press ENTER and type in the new value from the key-
board or the on-screen keyboard. Then press ENTER 
again.
Press the down arrow to move the cursor to the next 
field.
Horz. Distance: Horizontal distance to the feature from 
your current position. To input a value for Horz. Dis-
tance, press ENTER and type in the new value from the 
keyboard or the on-screen keyboard. Then press 
ENTER again.
Press the down arrow to move the cursor to the next 
field.
Vert. Distance: Vertical distance to the feature from your 
current position (“0” if the feature and yourself are at 
the same elevation -on a flat area). To input a value for 
Vert. Distance, press ENTER and type in the new value 
from the keyboard or the on-screen keyboard. Then 
press ENTER again.
Press the down arrow to move the cursor to the next 
field.

- Then tap OK to return to the Logging screen. This 
writes the offset into memory, but you can edit it later 
if you like by going through the same process. If you 
close the feature and return to the Map screen, you 
will see that the feature is offset from your position in 
the middle of the screen.



Line or Area Offset screen 

On the left On the right

Line Area

Visual estimation for horz. 
& vert. distances is usually 

good enough in terms of 
accuracy.
12.Offsetting a Line or Area Feature

For the same reasons as a point feature (see previous 
page), you may need to use the offset utility to map a line 
or area feature. By combining the receiver’s position with 
the direction and the distance to the feature, Mobile Map-
ping will automatically calculate and record the location of 
the feature.
To input an offset for a line or area feature, assuming the 
Feature List screen is now displayed, do the following:
- Tap one of the line or area features available from the 

open feature library.
- Tap the Log button to start logging the feature.
- Tap Options and then Offset. This displays the Line or 

Area Offset screen on which you should enter the fol-
lowing parameters:
Direction: Location of the feature with respect to your 
actual path. To input a value for Direction, tap the down 
arrow and then tap the desired option (Right or Left). 
Press the down arrow to move the cursor to the next 
field.
Horz. Distance: Horizontal distance to the feature from 
your current position. To input a value for Horz. Dis-
tance, press ENTER and type in the new value from the 
keyboard or the on-screen keyboard. Then press 
ENTER again.
Press the down arrow to move the cursor to the next 
field.
Vert. Distance: Vertical distance to the feature from your 
current position (“0” if the feature and yourself are at 
the same elevation -on a flat area). To input a value for 
Vert. Distance, press ENTER and type in the new value 
from the keyboard or the on-screen keyboard. Then 
press ENTER again.
15
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To operate the grid map-
ping utility, you will need a 
measurement device - any-
thing from a depth sounder 

to a ruler, your own sense 
of smell or your ability to 
make visual observations. 
You will also need a com-

pass. 
Press the down arrow to move the cursor to the next 
field.

- Tap OK to return to the Logging screen. This writes the 
offset into memory, but you can edit it later if you like 
by going through the same process.
Note: Offsets to area features are applied in 
MobileMapper Office and not in the receiver.

13.Logging GIS Data on a Preset Grid Feature

 The Grid Mapping Utility is an easy way to automatically 
set up a series of GPS waypoints to facilitate the logging 
of data in an orthogonal grid.This utility assures that you 
gather measurements made using field sensors such as 
chemical detectors, depth sounders and magnetometers 
at an evenly distributed set of locations. This in turn 
assures the creation in your GIS of contour maps with a 
prescribed density of data and without any gaps that 
might force you to return to the field.
The Grid Mapping Utility deals with two different grid con-
cepts: grid features and grid points.
- Grid features are arrays of uniformly spaced waypoints 

oriented in rows and columns
- Grid points are navigation features similar to way-

points.
Important Notice: Once you have logged a grid feature in a 
job (assuming the selected feature library allows you to do 
so), you cannot log any other feature type in the job, not 
even another grid feature. Conversely, once you have 
logged a point, line or area feature, you cannot log a grid 
feature even though the feature library selected for the job 
does initially include a grid feature type.
For this reason, you should collect your grid data in spe-
cific jobs.



GOTO will not be shown in 
the menu list if you press 
MENU while the unit dis-

plays the Map screen in 
cursor mode. In that case, 

just press NAV and then 
MENU again.

Grid Setup screen 
To log GIS data on a preset grid, do the following:
- If you have created a waypoint to help you locate the 

first grid point, you can use any of the navigation 
screens to get there. Press MENU and tap GOTO. 
Using the Left or Right arrow, make sure Alphabetical is 
selected at the bottom of the screen. Then tap User 
Waypoint. In the list of waypoints now displayed, tap 
the name of the waypoint you want to go to. Again, you 
may use any of the navigation screens to arrive at this 
waypoint

- Once you arrive at the point of beginning, you should 
open up the job file that includes the feature library 
describing the grid. If you opened an existing job, 
press LOG to take you to the New Feature screen. Then 
tap the grid feature type listed on the screen. Usually 
the term “grid” is included somewhere in the feature 
name so that you can easily recognize this type of fea-
ture. Tap the on-screen Log button. The Grid Setup 
screen appears on which you can read the definition of 
the grid (see opposite).
When you navigate to the location of the grid, you may 
decide to readjust the size and orientation of the grid 
based on field observations that you did not foresee 
back in the office. For example, you may find that nav-
igating to waypoints with an east-west orientation is 
not feasible if the area of interest is situated on a nar-
row strip of land between two north-south running 
streams.
17
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When you change the definition of a grid, Mobile Map-
ping always assumes that you are standing in the cor-
ner of the grid from which you can see the grid extend 
in front of you and to the right.
The definition of a grid is based on the following four 
parameters:

Spacing: Distance between any two consecutive way-
points in any row or column (default: 50 meters or 
100 feet, depending on the units used)
Columns: Number of waypoints along the axis facing 
you (default: 10; Max.: 100)
Rows: Number of waypoints along the axis perpen-
dicular to the direction you are facing (default: 10; 
Max.: 100)
Heading: Direction you face when the grid’s columns 
extend in front of you and the rows extend to your 
right.

- To change the above parameters, use the up/down 
arrows to move the cursor to each of these fields, press 
ENTER and edit the field using either keyboard. When 
you are done with the definition of a field, press 
ENTER. Then press the down/up arrow to access the 
next field, etc.

- Record an observation or measurement: Tap OK at the 
bottom of the screen. This takes you to the Logging 
screen that indicates that you have begun logging data 
to the feature and that the receiver is ready to log the 
feature's attributes. Remember that you remain sta-
tionary for all point features. Describe the feature as 
you would any other point feature.



It is also possible to navi-
gate to any grid point (or 

any location for that mat-
ter) on the Map screen by 
tapping over another grid 

point. After you record data 
at this location, you will 

still be prompted to go to 
the next grid point .
- Navigate to the next grid point: When you have fin-
ished recording the first point feature, tap Done. A 
message prompts you to go to the next grid point. Tap 
Yes to navigate to the next grid waypoint and record 
the next point feature within the grid. This takes you to 
the Map screen where you can see your current posi-
tion marked by the arrow and the next grid waypoint 
highlighted with a “crossed box” target symbol. Small 
hollow squares indicate the locations of all the unvis-
ited grid waypoints. Small filled squares (“black” 
squares) indicate the locations of where you recorded 
point feature.
As you begin moving toward the target symbol, you will 
see your heading indicated by the direction of the 
arrow marking your position. Adjust your movement as 
necessary until you are positioned over the target sym-
bol. You may also use any of the other navigation 
screens available. The Arrival alarm is disabled when 
navigating to grid points. It is best to note your dis-
tance to the next point and stop when this value goes 
to zero. When you arrive at the next grid point, press 
the LOG button and you will see the same Logging 
screen you used for the earlier measurement or obser-
vation.
Each grid point is a geographic coordinate you should 
make every effort to occupy so that the data you record 
is evenly spaced and complete. However, each grid 
point is merely an aid for navigating to the ideal loca-
tion for an observation or measurement. All the data 
you record is ascribed to the position of the receiver 
and NOT to the grid point.
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If you cannot physically occupy this point, but can 
make the necessary visual observation, you should do 
so and record an offset estimating the distance and 
bearing to the grid point. If you are recording measure-
ments made by an instrument, you should NOT record 
an offset but rather try to make a recording as close as 
possible to the position.

- When you have occupied as many of the grid points as 
you can and recorded the necessary observations and 
measurements at each, tap Done at the bottom of the 
Logging screen.

- Tap No when Mobile Mapping asks you to go to the 
next grid point.

- Press the LOG button and tap Yes to close the job.

14.Closing the Job

To close a job, from the screen showing the list of attributes, 
tap Done then confirm by tapping Yes.



Job List screen 

Screen prompting you to go 
to the selected feature

When you know which 
attributes must be changed 

for a point feature, which 
means you don’t really 
need to visit the point, 

then tap Edit rather than 
Goto and change the 

attributes directly.
Revisiting and Updating Existing 
GPS/GIS Jobs

You can use Mobile Mapping not only to position and describe 
new GIS features but also to update information gathered pre-
viously. This is particularly useful when collecting data on 
things that change over time: streetlight bulbs burn out, new 
roads are added to housing developments, new crops are 
planted, etc.

1. General Procedure

Return to the area where the original job was recorded, turn 
on your unit and double-tap the Mobile Mapping icon. When it 
has calculated a GPS position, follow the procedure below to 
update the job or to append more data to it.
- Press the LOG button and tap Open Existing Job.
- Tap the name of the job you want to revisit.
- Unless this screen is already displayed, press NAV repeat-

edly until the Map screen is displayed. The Map screen 
provides a geographical view of the different featutes 
present in the job. From this screen, you will now indicate 
the first feature you want to revisit. If necessary, press the 
IN or OUT button to adjust the scale so you can see this 
feature.

- On the Map screen, tap on the feature you want to revisit 
first. (The feature name appears in the lower part of the 
screen when the cursor is positioned over the feature.)

- When the map cursor is positioned over the feature to be 
updated, press ENTER. A new screen is displayed showing 
the attribute values currently ascribed to the feature. Note 
that the Goto field is highlighted at the bottom of the 
screen.
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Map screen showing 

straight line to target 
- Tap Goto to ask Mobile Mapping to guide you to this fea-
ture. By doing this, you will make the selected feature 
your destination and all the navigation screens will be set 
to help you reach that feature. The Map screen will also be 
automatically displayed showing a straight line connecting 
your current destination to the selected feature.

- Walk to the feature according to the navigation instruc-
tions provided on the Map screen. You can use other navi-
gation screens if you prefer (see also Navigation Screens 
on Navigation on page 28). You will know when you are 
close to the feature when the distance to the feature goes 
to zero or close to zero, or simply because you can identify 
it visually. Another nice way of being informed that you 
have arrived at the feature is to set the Alarms option.

- After arriving at the feature, press the LOG key. This takes 
you to the Feature Attributes screen.

- Now that you are near the feature and you can see which 
of its attributes need to be changed, tap successively each 
of these attributes and change them.

- After reviewing the attributes, tap the Done field at the 
bottom of the screen. This ends the review of this feature 
and displays the Map screen again.

- Follow the same steps described above to revisit and 
update the other features present in the job.



2. Repositioning a Point Feature

If a point feature appears to be mislocated on the Map screen, 
do the following after you have arrived at the feature:
- Press the LOG key and tap the on-screen Log button. Let 

Mobile Mapping recompute the point position and then 
tap the Done button to close the feature.
Note that only point features can be repositioned. If you 
wish to reposition a line or area feature, you should record 
a new feature and then delete the old one in MobileMap-
per Office.

3. Adding More Features and Attributes to the Job

If you want to add more features and descriptions to the exist-
ing job, you just have to record them exactly as you record fea-
tures into a new job.

4. Closing the Job

To close a job, from the screen showing the list of attributes, 
tap Done then confirm by tapping Yes.
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Tracking 3 satellites will in 
principle allow you to cal-
culate a 2D position (lat/

lon) using the last altitude 
recorded by the receiver. 

You need to track at least 4 
satellites to get a 3D posi-

tion (lat/lon/altitude). To 
achieve the specified accu-

racies, you will need to 
track 5 or more satellites.

GPS quality indicators
Quality Indicators

At the bottom of each logging screen, you can see two num-
bers that give you a good indication of how accurate the unit 
should be.
The first is the number of satellites that the receiver is track-
ing. A “W” will appear after the number of satellites if SBAS 
is used. The presence of this letter is indicative of an even bet-
ter accuracy level.
The second number is the Positional Dilution of Precision 
(PDOP), which is an estimate of accuracy that the receiver 
constantly calculates using the geometry of satellites in the 
sky. The more satellites that are being tracked and the more 
evenly they are distributed around the sky, the better the ac-
curacy. PDOP values less than 4 or 5 are good. If the PDOP 
value is over 5, you should consider moving to an area with a 
clearer view of the sky and recording features with offsets.
Mobile Mapping may warn you if the PDOP, and therefore the 
accuracy, of your positions has dropped below the level you se-
lected during Setup (see page 54, the PDOP alarm option). If 
you see this warning you may press the ESC button and con-
tinue logging.
However, if you are recording line or area features, you might 
want to return to the field when the GPS satellites are in a bet-
ter configuration overhead (the constellation changes slowly 
but constantly).
And if you are recording a point feature, you should strongly 
consider moving to another location with better satellite re-
ception and recording an offset (distance and bearing) to the 
feature.

Quitting the Mobile Mapping Function

Press the MENU key and tap Exit. This takes you back to the 
workspace screen.



Note: MobileMapper 
Office does not need an 

activation code. If the 
jobs you download to 
MobileMapper Office 

have been recorded 
using the “Post-pro-
cessing” job mode, 
then MobileMapper 

Office will let you post-
process them.
3. Post-Processing Option

MobileMapper Office includes a differential correction utility 
that can post-process GPS measurements recorded by Mo-
bileMapper CX for submeter accuracy. To record GPS mea-
surements with Mobile Mapping in a MobileMapper CX 
receiver, you need to first purchase a post-processing option.
When you purchase this option, you are given an activation 
code that you should enter into your MobileMapper CX receiv-
er. Because it is tied to the serial number of your MobileMap-
per CX receiver, the activation code is valid only for one 
receiver.

Enabling the Post-Processing Option

- Press the LOG key and select Create New Job.
- Name the new job and press ENTER.
- Select a feature library and press ENTER.
- Select Post-processing as the job mode. This opens the 

Activation Code screen.
- Overwrite the “0000000000” field with the activation 

code intended for your receiver. Use the on-screen keypad 
to enter your code.

- After entering the code, press ENTER. This enables the 
post-processing option in the receiver. Mobile Mapping 
comes back to the Setup menu where Post-processing is 
still highlighted but you can no longer access the Activa-
tion Code screen.
25
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Welcome screen

Job Mode screen
Creating a New Job with 
the Post-Processing Option

- If there is a job that is currently open, close it by pressing 
MENU and selecting Close Job

- Press LOG. MobileMapper CX displays the Welcome 
screen. This screen shows three options (instead of two 
when the post-processing option is not enabled).

- Highlight Create New Job and press ENTER.
- Enter the job name as explained earlier (see page 6).
- After entering the name, highlight the OK key on the 

screen and press ENTER. A new screen is then displayed 
listing the feature libraries stored on the receiver’s SD 
card.

- Highlight the library you want to use and press ENTER. A 
new screen is then displayed asking you to choose the job 
mode:
• Real-time: If you select this job mode, the receiver will 

record only feature positions and descriptions and GPS 
metadata. Jobs recorded in real-time mode cannot be 
differentially corrected later on.

• Post-processing: Select this job mode to allow 
MobileMapper CX to record the job so that later on, it 
can be post-processed in MobileMapper Office. In this 
job mode, MobileMapper CX will record GPS measure-
ments files in addition to the MMJ job file that is 
recorded in real time.

- Use the down/up arrow to highlight Post-processing and 
then press ENTER. The screen now lists all the features 
available from the selected feature library.

- At this stage, use Mobile Mapping in exactly the same way 
as you would without the post-processing option being 
enabled. See page 6 and following.



Site ID screen
Using MobileMapper CX 
as a Reference Station

- Mount MobileMapper CX on a tripod placed over a control 
point, turn it on and press ENTER at the agreement 
screen

- Press LOG. MobileMapper CX displays the Welcome 
screen.

- Highlight Reference Station and press ENTER. The Site ID 
screen is now displayed.

- Enter a Site ID (there is a four-character limit) as you 
would enter a job name, highlight OK on the screen and 
press ENTER.

From now on, MobileMapper CX will operate as a refer-
ence station until you exit Mobile Mapping. It is therefore 
important that you not move the receiver or any optional 
external antenna until you exit from Mobile Mapping.
Before leaving the reference station for your work, press 
the NAV key until you can see the Satellite Status screen. 
The letter “R” appears in the upper-right when the 
receiver is recording reference station data.
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The Map screen has two 
modes: Position and Cur-
sor. Using the stylus, tap 
anywhere on the map, or 

press any arrow key, to 
select Cursor mode. Press 
ESC to return to Position 

mode. 

When a Position screen is 
displayed, press the Left or 

Right arrow key to display 
the other. Press this key 

again to return to the previ-
ous screen.

Except for the Satellite 
Status screen, all naviga-
tion screens can be cus-

tomized. 
4. Navigation

Mobile Mapping offers very helpful navigation functions that 
you can use while performing your field operations.
The present chapter tells you how to use the navigation 
screens, how to create waypoints and how to work with the 
GOTO and Routes functions.

Navigation Screens

Mobile Map-
ping offers 7 
different navi-
gation screens 
to help you lo-
cate yourself or 
navigate to way-
points or GIS 
features in an 
existing job. 
From any dis-
played screen, 
simply press the NAV button to access the last-used naviga-
tion screen. To display the next navigation screen, press NAV 
again. The sequence of navigation screens is as shown above. 
It can be scrolled in the reverse direction by pressing ESC 
once any of these navigation screens is displayed.
You may find that you do not regularly use all of these screens. 
To make it faster to move among those screens that you do 
use, you may turn off individual navigation screens (except 
the Map and Satellite Status screens) by pressing the MENU 
button, selecting the Setup option and then the Nav Screens 
option.

Press NAV

Position Screen 2

Large Data Screen

Compass Screen

Map Screen

Satellite Status Screen

Speedometer Screen

Data Screen

Road Screen

Position Screen 1

Press NAV

etc.



Map screen in Position 
mode

Map screen in Cursor mode
Select either On or Off for each screen until you see the Setup 
menu once more. Note that you must cycle through all the 
screens in order to put your selections into effect.
The following is a description of each of the navigation 
screens.

Map Screen
The Map screen shows a map of the area surrounding your cur-
rent location. Use the IN and OUT buttons to adjust the scale.
The Map screen is always in the Position mode when you ac-
cess this screen. In this mode, your present position is indi-
cated by the large arrow icon in the center of the display. If 
you are moving, the arrow will point in the direction that you 
are heading. At the bottom of the screen is the scale for the 
map displayed and two data fields that can be customized, or 
turned off, depending upon your needs.
The present position icon will change to an hourglass when 
Mobile Mapping is unable to compute a position fix due to 
poor signal reception.
Tap anywhere on the Map screen or press any of the arrow keys 
to switch to the Cursor mode. In this mode, you are provided 
with a cross hair cursor that can be moved using the stylus 
(you tap directly where you would like the cursor to be) or, for 
a step-by-step move, by using the arrow keys.
At the bottom of the display is the information for the position 
of the cursor relative to your present position (heading and 
distance). Also any points of interest or GIS features that the 
cursor is over will be shown.
To return to the Position mode, press ESC. The cursor will dis-
appear and the present position icon will appear centered on 
the map.
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Compass screen

Large Data screen
Compass Screen
The two data fields on top are customizable. The lower portion 
of the Compass screen displays your heading in a graphical 
manner.
The Compass screen contains the following information, from 
top to bottom:
- In the title bar: destination name if you are using the Goto 

function
- Data Fields: customizable data fields (see Customize 

option on page 58). Some of the data displayed requires 
you to be moving to be computed. Invalid data is indi-
cated by dashes.

- Icon representing destination: Displayed outside the com-
pass when you are using the Goto function. This provides 
you with the direction you need to head to arrive at the 
destination. When you are on course and heading straight 
for the destination, the destination icon will be lined up 
with the heading marker.

- Compass/Heading marker: Using the compass and the 
heading marker, you can view your heading information in 
a familiar manner. Note that you need to be moving for 
this data to be valid.

Large Data Screen
The Large Data screen is similar to the Compass screen but 
here the compass has been removed to allow for large display 
of the navigation data. This screen is ideal for when you have 
your unit mounted on the dashboard of a vehicle. Even from a 
distance the customizable information can be read with ease.
The Large Data screen contains the following information, 
from top to bottom:
- In the title bar: destination name if you are using the Goto 

function
- Data Fields: customizable data fields (see Customize 

option on page 58). Some of the data displayed requires 
you to be moving to be computed. Invalid data is indi-
cated by dashes.



Position screens 1 & 2

To switch from a screen to 
the other, just press the 
Left or Right arrow key.

The same data as on Posi-
tion screen 1 is displayed 

on Position screen 2 
except that the lower part 
of the screen, containing 

the two data fields and the 
trip odometer field, is 

replaced with the current 
position’s coordinates 

expressed in the chosen 
secondary coordinate sys-

tem and map datum.
Position Screens
Position screens #1 and #2 display your present position us-
ing the coordinate systems that you have selected (see how to 
select these systems in the two sections Coord System on 
page 51 and Map Datum on page 52.
This screen shows all of the basic position, time and satellite 
information. Additionally, on Position screen #1, current nav-
igation information is shown in the bottom half of the screen.
For the sake of comparison, Position screen #2 provides the 
coordinates of your present position both in the selected pri-
mary coordinate system and map datum, and in the selected 
secondary coordinate system and map datum.
Position screen #1 contains the following information, from 
top to bottom:
- Coordinates and elevation of your current position: Dis-

plays your current position in the chosen coordinate sys-
tem. Also displays the elevation of the current position. If 
Mobile Mapping is not computing position fixes, the last 
computed position is displayed.

- GPS Satellite Status/Position Status: Provides information 
on the current status of the GPS receiver (see table 
below).
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- Data Fields: customizable data fields (see Customize 
option on page 58). Some of the data displayed requires 
you to be moving to be computed. Invalid data is indi-
cated by dashes.

- Trip Odometer: The odometer performs like the odometer 
in your car. It can be reset through the MENU button.

To customize the Position screens, use the functions de-
scribed below. The first of these context-sensitive functions is 
prompted when you press the MENU button while a Position 
screen is displayed. Some of these functions also exist in the 
Setup menu.

Message Description
Searching - 1st sat Searching for 1st satellite.

Searching - 2nd sat 1st satellite found; searching for 2nd satellite.

Searching - 3rd sat 2 satellites are being tracked; searching for a 3rd.

Searching - 4th sat 3 satellites are being tracked; searching for a 4th.

Collecting Data All satellites needed for position fix are being tracked 
and position is being computed.

Averaging Mobile Mapping is computing fixes; speed is near 0.0 
and so position is being averaged.

WAAS Averag Mobile Mapping is computing fixes using SBAS; speed 
is near 0.0 and so position is being averaged.

EPE xxx. Estimated Position Error. Mobile Mapping is computing 
fixes while moving.

DGPS
DGPS Averag

Computed fixes are being differentially corrected using 
RTCM corrections (“DGPS Averaging” when speed near 
0.0.).



Road screen

Data screen
Road Screen
The Road screen presents your route as if you were travelling 
on a road. When you need to make a turn, the road will graph-
ically display the turn and the direction. Waypoint and desti-
nation icons will be displayed relative to your position as they 
come into view. Above the road is a compass that displays your 
heading and above that are four customizable data fields.
The Road screen contains the following information, from top 
to bottom:
- In the title bar: destination name if you are using the Goto 

function
- Data Fields: customizable data fields (see Customize 

option on page 58). Some of the data displayed requires 
you to be moving to be computed. Invalid data is indi-
cated by dashes.

- Compass: Displays your heading in a familiar compass for-
mat.

- Road: This graphically displays the route (Goto) that is 
active. As you move left or right of your intended track, the 
road will move on the display indicating which way you 
need to steer to get back on track. Ideally, the road would 
be centered on the display. Also, you will see upcoming 
turns in advance allowing you to make necessary prepara-
tions.

- Scale indicator: Use Zoom In/Out to change the scale.

Data Screen
When you need to see a lot of information in one place then 
you will appreciate the Data screen. The Data screen provides 
you with six data fields and an active compass that is the same 
as the one used on the road screen. You have the option of 
customizing this screen by selecting what data is displayed in 
the upper six fields. The lower portion of the screen is occu-
pied by a compass providing your heading.
The Data screen contains the following information, from top 
to bottom:
- In the title bar: destination name if you are using the Goto 

function
- Data Fields: customizable data fields (see Customize 

option on page 58). Some of the data displayed requires 
you to be moving to be computed. Invalid data is indi-
cated by dashes.

- Compass: Displays your heading in a familiar compass for-
mat.
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Speedometer screen

Satellite Status screen
Speedometer Screen
The Speedometer screen displays your speed in a familiar 
graphical format. There are four additional data fields at the 
top of the display that can be customized to display the data 
that you need. The bottom of the screen contains a trip odom-
eter that will record the distance travelled since the last time 
the odometer was reset.
The Speedometer screen contains the following information, 
from top to bottom:
- In the title bar: destination name if you are using the Goto 

function
- Data Fields: customizable data fields (see Customize 

option on page 58). Some of the data displayed requires 
you to be moving to be computed. Invalid data is indi-
cated by dashes.

- Speedometer: Displays your speed using a familiar speed-
ometer display. The scale of the speedometer is not 
adjustable but will change dynamically to best display 
your speed.

- Trip Odometer: The odometer performs like the odometer 
in your car. It can be reset through the MENU button.

Satellite Status Screen
Although the Satellite Status screen is part of the navigation 
screen sequence, it is not actually a navigation screen.
When Mobile Mapping is computing your position, an addi-
tional information appears in the right-upper corner with two 
possible values: 3D or 2D. 3D means the computed position 
is 3-dimensional (elevation computed). In 2D (2-dimension-
al), elevation is not computed. Mobile Mapping assumes that 
the last computed or entered elevation is the elevation for all 
computed positions.
 See also page 4.



List of POI categories
GOTO Function

Purpose
You use the GOTO function to ask Mobile Mapping to guide 
you from your current position to a destination point.
After you will have specified which destination point to go to, 
you will select your favorite navigation screen. You will then be 
able to read the information computed by Mobile Mapping to 
help you reach the destination.

Destination Point Types
Mobile Mapping can guide you to:
- Any point of interest (POI) pre-loaded in the unit.
- Any waypoint created using the Mark function. This type 

of point is listed as a “User Waypoint” category in the POI 
(Point Of Interest) database.

- The active background map (as set in the DetailMap field 
on the MENU>Setup>Select Map screen), which appears on 
top of the POI list (see oposite).

- Any feature logged in the open GIS job which you will 
select graphically on the Map screen.
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GOTO will not be shown in 
the menu list if you press 
MENU while the unit dis-

plays the Map screen in 
cursor mode. In that case, 

just press NAV and then 
MENU again.
Selecting a POI as the Destination Point
Press MENU and tap GOTO. The possible categories of POIs 
are now listed on the screen. Use the Up/Down arrow keys to 
highlight the category the destination point belongs to.
Before pressing ENTER to list all the points stored in this cat-
egory, choose how you want these points to be listed by setting 
the Find By field. Press the left/right arrow to set this field. Two 
values are possible in this field: 
- Alphabetical: Points will be listed in alphabetical order. 

Mobile Mapping will then help you find the desired point 
through one of the following two methods: Keyboard 
Search and Alphabetic Scroll.
Keyboard Search: Before displaying the list of points in 
alphabetical order, Mobile Mapping displays a keyboard 
that you can use to enter the first few characters of the 
point you are looking for. When you press ENTER, you are 
taken to the alphabetical list with the point you began typ-
ing at the top of the display. Anytime you are viewing the 
list of points, you can re-access the keyboard by pressing 
ESC.
Alphabetic Scroll: When the alphabetical list is displayed, 
you can use the IN and OUT buttons to step up or down 
the alphabet. If you were viewing points beginning with 
the letter “A”, pressing OUT would take you to the first 
waypoint beginning with “B”, and then “C” and so forth. 
Pressing IN does the same function but only in reverse.

- Nearest To: Only the 20 points from this category the clos-
est to either your position or another POI will be listed.



Selecting a GIS feature as 

the destination
When these 20 points are listed, Mobile Mapping indicates 
the bearing and distance to your current position from the first 
point in the list. You can change the point from which the 
nearest points are found. With the Nearest To field now high-
lighted, press ENTER and scroll to the category where this 
new point can be found. Select a new point and press ENTER. 
If you have already pressed the arrow keys and one of the near-
est points in the list is highlighted, use the ESC button to 
scroll back to the Nearest To field.

Selecting a GIS Feature as the Destination Point
Assuming a GIS job is open and contains already logged fea-
tures:
- Press NAV until the Map screen is displayed.
- Using the IN and OUT buttons, adjust the scale in such a 

way that you can see the feature you want to go to.
- Using the stylus, tap this feature. You know that the cursor 

is positioned over the feature when the “Cursor” indica-
tion at the bottom of the screen is replaced with the name 
of that feature. You may use the arrow keys to refine the 
position of the cursor over the feature.

- Press ENTER. A new screen appears giving the current 
description of the feature. At the bottom of the screen, 
simply tap Goto to enable the Goto function with this fea-
ture as your destination. Then select your favorite naviga-
tion screen, using the NAV button, and navigate to this 
feature.
37



38

Mark screen

Select Item screen
Saving Your Current Position as a Waypoint
Saving your current position as a waypoint is very easy and can 
be done from within the Survey or GIS function.
From any screen, just press the MENU button, and select the 
Mark option. The Mark screen appears. This screen provides 
the description of the waypoint you are about to save.
You can accept all the defaults by simply pressing ENTER 
(Save field already highlighted).
You can also edit the Icon, Name and Message fields using the 
arrow keys to access these fields. Obviously you should keep 
the Location and Elevation fields unchanged as they contain 
the coordinates of your current location.
Waypoints recorded using the receiver's Mark feature are not 
exportable by MobileMapper Office. If you wish to record way-
points in the field and export them to GIS formats, you should 
use MobileMapper Office's Feature Library Editor to create a 
"Waypoint" feature type. You can then log a "waypoint" as a 
point feature while recording a job file.

Editing/Deleting a User Waypoint
You can edit/delete a waypoint from the Map screen:
- Press NAV until the Map screen is displayed
- Use the IN or OUT button, or move the cursor so that the 

waypoint you want to edit or delete is visible on the screen
- Position the cursor over that waypoint. The name of the 

waypoint then appears at the bottom of the screen.
- Press ENTER. This opens the Select Item screen on which 

Mobile Mapping lists the names of the items present in 
the vicinity.



Select Item screen
- Tap the waypoint you want to edit/delete. This opens the 
User Waypoint screen on which you can see the definition 
of the waypoint (coordinates+comments). At the bottom of 
the screen are three command fields that you can use for 
the following tasks:
Edit (default choice): Select this field if you want to edit 
the definition of the waypoint. The following parameters 
can be changed: icon, name, coordinates, elevation and 
comment.
Goto: Select this field if you want Mobile Mapping to guide 
you to this waypoint
Del: Select this field if you want to delete the waypoint. 
Mobile Mapping will then ask you to confirm that you 
really want to delete the selected waypoint.

Clearing the GOTO function
To ask Mobile Mapping to stop guiding you to a destination 
while the Map screen is displayed in position mode:
- Press MENU
- Tap GOTO. A message appears asking you to confirm that 

you would like Mobile Mapping to stop guiding you to this 
point.

- Tap Yes
- Press ESC to return to the Map screen.
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A GOTO route is a one-leg 
route whose two ends are 
your current position and 

the chosen destination 
point.

WPT1

WPT2
WPT3

WPT4

WPT5

WPT6
Routes

As explained below, Mobile Mapping can handle two types of 
routes: GOTO route and multi-leg route.

GOTO Route
This in fact a route that you define when:
- You select a waypoint on the Map screen, you press 

ENTER twice to display the properties of this waypoint, 
and you tap GOTO to enable the Goto function to this way-
point . The same can be done to choose a POI or a GIS 
feature as the destination point.

- You use the GOTO option after pressing MENU and you 
choose a POI or waypoint as the destination point.

GOTO routes are not saved in memory. When you turn your 
unit off and then back on, the GOTO route is gone. You need 
to create a new GOTO route if you intend on completing the 
route.

Multi-leg Route
A multi-leg route consists of several waypoints or POIs that 
you should reach one after the other. The segment between 
any two consecutive waypoints or POIs is called a “leg.” Un-
like GOTO routes, multi-leg routes can be stored in memory.
The backtrack route also belongs to the category of multi-leg 
routes (see page 42).



Create Route screen

Route List screen
1. Creating a Multi-leg Route

- Press MENU and tap Routes. The Route List screen is now 
displayed.

- Tap the first Empty route in the list.
- Press MENU and tap Create New Rte. The Create Route 

screen is now displayed and the first line on this screen is 
highlighted.

- Press MENU and tap Insert WPT. The Insert WPT screen is 
now displayed.

- Press the Left or Right arrow to select Alphabetical at the 
bottom of the screen.

- Tap User Waypoint 
- Browse the list of available waypoints and tap the name of 

the waypoint you want to define as the first waypoint in 
the route. You are then prompted to define the second 
waypoint in the route.

- Resume the previous 4 steps to define the next waypoints 
in the route.

- When the last point of the route is defined, tap the Save 
Route button on the Create Route screen.

2. Activating/deactivating a Multi-Leg Route

- Press MENU and tap Routes.
- In the Route List screen now displayed, tap the route you 

want to activate.
- Press MENU and tap Activate Route. Mobile Mapping 

comes back to the Route List screen where the activated 
route now appears in bold characters. Press NAV to navi-
gate along this route.

To deactivate this route:
- Press MENU and tap Routes, 
- Tap the activated route in the list
- Press MENU and tap Deactivate Route. The route is now 

deactivated.
41



42
3. Asking Mobile Mapping to Retrace your Steps

If the Track Mode is active (see page 49), Mobile Mapping au-
tomatically creates and stores hidden points into memory as 
you move. This series of points is called the “track” or “track 
history”. To retrace your steps, do the following:
- Press MENU and tap Routes.
- Select Backtrack.
- Press MENU again and tap Activate Backtrk. A message 

appears warning you that the Track History Logging is now 
disabled.

- Tap OK and press NAV to return to the Map screen. Now 
let Mobile Mapping guide you along the existing track, 
using the track’s hidden points as navigation waypoints, to 
go back to the track’s start point.

4. Creating a Route from the Track History

- Press MENU and tap Routes.
- Select Backtrack.
- Press MENU again and tap Save Trk to Rte. Mobile Mapping 

converts the track’s hidden points into User Waypoints. 
The new route then appears on the Route List screen. It 
consists of waypoints that are numbered “TxxPyy” (where 
xx is the route number in the list and yy is the order num-
ber of the waypoint in the route).
For example the created route could be named “T01P01 
.. T01P07”. 
Note that the the route is a copy of the track and not the 
backtrack.



5. Other Functions Tied to Routes

You can also do the following on the highlighted route using 
the functions available from the MENU button (see also dia-
gram on page 47):
- Viewing the route on the Map screen by pressing MENU 

and tapping Map View Route. The Map screen then appears 
showing the route. Press ESC to come back to the Route 
List screen.

- Editing the route by pressing MENU and tapping View/Edit 
Route. From the View/Edit screen you can then press the 
MENU button to access options allowing you to insert, 
delete, replace the highlighted waypoint and then to save 
the changes made to the route.

- Reversing the route, i.e. reversing the direction of travel 
along the route, by pressiong MENU and tapping Reverse 
Route. This instantly reverses the route. Note that the first 
and last waypoints in the route name have been swapped.

- Deleting the route by pressing MENU and tapping Delete 
Route. A message will appear asking you to confirm this 
operation.

- If a route has been activated, selecting the leg you want to 
follow by pressing MENU and tapping Select Leg. The 
screen then shows the list of points making up the route. 
Tap the waypoint you want to navigate to. A warning mes-
sage will appear asking you to confirm the leg change. 
After choosing Yes or No, press ESC twice to return to the 
navigation screen.
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The MobileMapper CX 
MENU key is inactive until 
you double-tap the Mobile 

Mapping icon.
5. MENU key

The diagram below shows the available functions when press-
ing MENU. When you select the Setup option in the menu list, 
another menu is displayed containing a number of options, as 
shown in the diagram below.

All the options available from the Menu screen are described 
below.

File Manager

This option allows you to list the files stored in the internal 
memory or SD card, depending on the choice you have made 
through Setup and Storage.
A sign is placed before each filename. The meaning of this 
sign is as follows:

+ Indicates that the file has not yet been downloaded from 
the handheld
- Indicates that the file has been downloaded from the 
handheld.

File Manager
Mark
GOTO
Routes
Setup
Customize
About...
Exit

Storage
Select Map
Map Setup
Nav Screens
Coord System
Map Datum
Time Format
Units
Alarms
North Reference
Beeper
Reset Trip
Clear Memory
Simulate
Language

(Available only when 
a customizable navi-
gation screen is dis-
played)

(Not available if Map 
screen displayed in 
cursor mode)



The name, last modification date and size of the selected file 
is shown at the bottom of the screen. Only the following file 
types are listed:

- R*.* (Raw data files)
- *.MMJ (GIS job files)
- *.MMF (GIS feature library files)
- *.IMI (Map files)

You can delete the selected file or all the files by tapping re-
spectively Delete or Delete All and then Yes to confirm.
(Delete All does not delete waypoints, track, routes and user 
settings but only the listed files, as opposed to Clear All in Clear 
Memory which deletes all waypoints, track and routes but does 
not impact user files; see page 56.)
When the internal memory is selected for storage, you can 
copy files to the SD Card you have previously inserted in the 
unit. Tap the Copy button and then one of the following op-
tions:

- All Files: All listed files are copied to the SD Card
- Selected File: Only the highlighted file is copied to the 

SD Card
- New Files: Only the files with filenames preceded by 

“+” are copied to the SD Card.

Mark

This option allows you to quickly create a new waypoint whose 
default coordinates will be those of your current location.
A typical use of this option is when you are located at a new 
point of interest and you wish to log its position.
When you select Mark in the menu list, the Mark screen is dis-
played with the following default values:
-  Default icon in the Icon field
- “WPTxxx” as waypoint name in the Name field. “xxx” is a 

number that the unit automatically increments as you cre-
ate new waypoints

- Coordinates of your current location in the Location and 
Elevation fields

If you agree with all these parameters, and as the Save field is 
already selected at the bottom of the screen, you just have to 
press ENTER to create the new waypoint. This is the fastest 
procedure to create a new waypoint.
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On the other hand, if you have to change any of these param-
eters or add a comment in the Message field, then you have 
first to edit the corresponding fields before selecting the Save 
field and pressing ENTER
The Route button gives direct access to the Route List screen 
where you can insert the newly created waypoint into a new or 
existing route.
If you would like to add more description or if you would like 
to export a waypoint to your GIS, use a feature library that in-
cludes a point feature called “Waypoint” and whatever level of 
attribution that you need. Then, when you want to record a 
waypoint, you can select the Waypoint feature type from the 
feature library and record a fully describable and exportable 
point feature.

GOTO

This option is discussed in detail on page 35.



Routes

This option is discussed in detail on page 40. The MENU but-
ton gives access to a list of specific options when the Routes 
option is enabled. This is summarized in the diagram below.

Insert WPT
Delete WPT
Replace WPT
Save Route

From View/Edit 
Route screen

Activate Route
View/Edit Route
Reverse Route
Delete Route
Save Trk to Rte
Map View Route

Deactivate Route
Select Leg
View/Edit Route
Reverse Route
Delete Route
Save Trk to Rte
Map View Route

From Route List 
screen, route high-
lighted and activated

From Route list 
screen, route 
highlighted, not 
activated

From Route List 
screen, empty 
route highlighted

Create New Rte
Save Trk to Rte

Deactivate
Advance Leg
Save Trk to Rte

From Route list 
screen, backtrack 
route highlighted, 
activated

Activate Backtrk
Save Trk to Rte

From Route list 
screen, backtrack 
route highlighted, 
not activated
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Setup Menu

Storage
This option allows you to choose the media to which the 
unit will save the data collected in the field. There are two 
possible choices:
• Internal Memory
• SD Card 

Select Map
This option is mainly used to choose the background maps 
(vector map and/or raster map) that the unit will display 
on the Map screen. The following parameters can be set 
on the Change Map screen:
- Basemap: Only the Default Map option can be selected 

in this field. The default map – an American or Euro-
pean map – is always present in the unit.

- Detail Map: Select the desired vector map from the list 
attached to this field.
Vector maps are IMI files downloaded into the unit 
using MobileMapper Office. Only one vector map can 
be displayed at a time. 
The list attached to the Detail Map field includes IMI 
files from both the internal memory and the SD card, 
whatever the storage setting.
If you did not upload any vector map to the unit, then 
Empty is the only option available for this field. The 
extent of a vector map is usually limited to the extent 
of the area you are working in.

- Raster Map: Use this field to select the raster map you 
want to view. Raster maps are in TIFF or GeoTIFF for-
mat. The drop-down list associated to this field lists 
the names of the raster map files found on the inserted 
SD card. 

After choosing the desired options for these parameters, 
tap Save.
Maps are arranged as follows on the Map screen: raster 
map at the front, basemap at the back, vector map in 
between.



Map Setup screen, 
Format tab

Fixed Rate

Auto

Auto Detailed
Map Setup
This option allows you to set the viewing options for the 
Map screen.
On the Format tab, you can set the following parameters:
- Orientation: You can change how the map is orientated 

on the screen to either North Up, Course Up or Track 
Up. Default is North Up.

- Detail: Use this field to set the detail for both the 
basemap and the detail map. This field can be set to 
highest, high, medium, low or lowest. This changes 
the zoom level that different map objects (cities, high-
ways, labels, etc.) are displayed. If you have set a 
zoom level and the display is too cluttered, set the 
map detail to a lower level; conversely set it to a higher 
level to view more detail.

- Track Mode: Allows you to set how often the unit stores 
track points:
•  Off: Stops the unit from saving any new track 

points.
• Auto: The unit uses a method for track point storage 

that maximizes memory. Using Auto, you will see 
more points on and near turns and less points on 
straight stretches of the map.

• Auto Detailed: Same as Auto but with more track 
points on and near turns.

• 2.0 km, 1.0 km,..., 0.05 km, 0.01 km: Fixed time inter-
vals for track point storage.
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Map Setup screen, 

Display tab
Please note that the Track Mode will be automatically  
set to Off when you start logging a new feature in the 
open GIS job. This is to avoid confusion on the Map 
screen between features and track points. The Track 
Mode will be automatically restored with its initial set-
tings when you close the GIS job.

- Primary Usage: The unit can be set to either Land or 
Marine usage. When in Land (default), the map dis-
plays land areas in white and water areas in blue. For 
marine applications it may be desirable to reverse the 
display, showing water as white and land as blue. This 
will make reading some of the data information on the 
water easier.

From the Display tab, you can customize the Map screen 
by specifying the items that the unit should display on the 
map:
- Show Map Info: Use this option to show or hide the two 

data fields displayed at the bottom of the Map screen. 
To customize these fields, see Customize on page 58.

- Waypoints (default: checked)
- Track Lines (lines connecting track points if Track Mode 

different from Off; see page 49)
- Pos-Dest Line (line connecting current position to desti-

nation)
- Depart-Dest Line (line connecting initial position to des-

tination)
Check the items you want to show and clear those you 
want to hide. You can also check or clear all these items in 
a single operation by respectively selecting Mark All or Clear 
All just above these items.
Press ESC or NAV to quit the Map Setup screen.



Nav Screens
This option allows you to remove the navigation screens 
that you do not need from the navigation screen sequence 
that you scroll by pressing NAV repeatedly (see page 28).
When selecting this option, you are asked to turn off or on 
each of the available navigation screens. Tap “Off” for all 
these screens that you are not currently using. Note that 
the Map screen cannot be turned off. You must cycle 
through all the screens in order to save any changes to the 
On/Off status of any screen.

Coord System
This option allows you to define a primary coordinate sys-
tem, and also a secondary coordinate system if you need 
one.
By defining a coordinate system, you tell the unit how the 
calculated coordinates should be expressed. For example, 
if you choose Lat/Lon, all coordinates will be expressed as 
angles (latitudes and longitudes) and if you choose UTM or 
any other system, coordinates will all be distances (North-
ings and Eastings) from the chosen origin.
When you select the Coord System option from the Setup 
menu, the unit asks you to specify which system you want 
to define (primary or secondary). Tap one. In the list that 
appears, tap the coordinate system you want to use. 
Depending on your choice, the unit may then ask you 
additional information:
- If you select Lat/Lon, you are then asked to select the 

display format (DEG/MIN.MMM, DEG/MIN/SEC.SS, 
etc.)

- If you select any system other than Lat/Lon or UTM, 
you are asked to choose a scaling factor for displaying 
position coordinates: 1 meter, 10 meters or 100 
meters. If you choose 1 meter, a northing coordinate 
will be displayed as, for example, 249143N. If you 
chose the 10-meter factor, the same coordinate will be 
displayed as 24914N. And if you select the 100-meter 
factor, the coordinate will be displayed as 2491N.

- For some systems, you are asked to supply information 
on grid zones or types
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- For the User Grid, you are asked to supply a projection 
type (Transverse Mercator, Lambert Conic, Stereo-
graphic, Oblique Mercator or Polyconic), coordinates 
of origin, scale factor, unit to meters conversion and 
false Easting and Northing at origin

Notes on Coordinate Systems:
- The unit always uses the WGS 84 coordinates to locate 

the features and waypoints on the Map screen, even if you 
select some other coordinate system/datum.

- The coordinate systems and datums used to display any-
thing on the Map screen are only for display. When you 
select some other coordinate system/datum, only the num-
bers of the coordinates of a feature/waypoint are changed. 
The map screen is not changed in appearance.

Map Datum
This option allows you to define a primary map datum, 
and also a secondary map datum if you need one.
A map datum is a geographic reference that the unit will 
refer to to calculate the coordinates of your position. The 
unit holds more than 70 different map datums in its mem-
ory.
After selecting the Map Datum option from the Setup 
menu, tap the map datum that applies to your country and 
working area.



To enter a user map datum, select the term “USER” in the 
list of datums arranged in alphabetical order. Depending 
on the type of map datum you want to define, up to nine 
different parameters, distributed on two different screens, 
may have to be defined:
1st screen:

Delta A (meters)
Delta F (X 10,000)
Delta X (meters)
Delta Y (meters)
Delta Z (meters).

2nd screen (select Next> at the bottom of the 1st screen 
to access this screen):

Rotation X (seconds)
Rotation Y (seconds)
Rotation Z (seconds)
Scale factor (ppm).

Tap Done to complete the definition of the user map 
datum. This takes you back to the Map Datum list where 
“USER” is selected. Tap twice to return to the last dis-
played navigation screen.

Time Format
This option allows you to select the time format you want 
to use in the unit. You can choose from three different 
time formats: Local 24Hrs, Local AM/PM or UTC.
After selecting the Time Format option from the Setup 
menu, just tap the time format you want to use.
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Units
This option allows you to select the units of measurement 
that will be used when displaying navigational data or fea-
tures being logged.
All sets of units are formatted as follows: long distance unit/
short distance unit/speed unit/area unit. You can select from 5 
different sets of units.
You can also create your own set of units by selecting 
Advanced at the end of the list. You are then prompted to 
specify the unit you wish to use for each type of possible 
measure, i.e. Distance, Speed, Elevation, Bearing and 
Area.
After selecting the Units option from the Setup menu, tap 
the set of units you wish to use. If you have selected 
Advanced, a new list appears prompting you to choose a 
unit for each type of measure. Tap the first measure in the 
list and then tap the desired unit. This takes you back to 
the former screen where you can select the second mea-
sure, etc. When all units are defined, press ESC to come 
back to the Setup menu.

Alarms
All of the Alarm options are set in the same way. The 
instructions below apply to all of the Alarm settings. When 
the beeper is turned on for alarms (see Beeper option) an 
audible beep will be sounded for the alarm. A visual alert 
is displayed for the alarm whether the beeper is turned on 
or off.
Setting the Arrival Alarm: The arrival alarm alerts you that 
you have arrived at the destination of your GOTO route or 
to the destination of any leg in a route you are navigating 
on.



This option allows you to set how close you must come to 
the destination before the alarm begins to sound.
After the alarm sounds, you can reset the arrival alarm to a 
shorter distance, but this shorter distance will apply to the 
next target and not to the current one. If you want the 
alarm to sound again when you come within a shorter dis-
tance to the current target, first select another target des-
tination and then reselect the original target.
Setting the PDOP Alarm: This turns on or off the alarm 
that can sound whenever the unit has lost its ability to 
compute accurate position fixes due to poor geometry of 
the GPS constellation. Generally, PDOP values less than or 
equal to “5” are indicative of good operating conditions. 
So it is a good idea to set this alarm to “5.” To turn off the 
PDOP alarm, enter “00.”
Note: Apart from the Arrival and PDOP alarms, the unit 
will generate a warning message on the screen in each of 
the following two cases:
- “Low Memory.” This message will appear when the 

receiver is running out of memory. If raw data is being 
collected, then the occurrence of this message will 
automatically stop data logging. You will however be 
allowed to enter the attribute values of the current GIS 
feature before the job is closed.

- “Out of Memory.” This message will appear when the 
memory is full. The occurrence of this message will 
immediately end raw data collection or close the cur-
rently open GIS job and you will not be able to log any-
thing until you free some space in memory.

North Reference
This option allows you to define the type of North refer-
ence you want the unit to use. This can be True North, 
Magnetic North, Military True North or Military Magnetic 
North.
After selecting the North Reference option from the Setup 
menu, tap the desired North Reference from the displayed 
list.
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Beeper
This option allows you to enable (On) or disable (Off) the 
beeper.
After selecting the Beeper option from the Setup menu, 
tap the desired option.

Reset Trip
If you tap this option, a warning message is displayed ask-
ing you to confirm your choice. To reset the trip odometer, 
tap the Yes button.

Clear Memory
This option allows you to clear one of the following data 
sets from the unit’s memory:
- Track history: Will clear the track shown on the Map 

screen.
- Wpts/Routes: Will clear all waypoints and routes from 

memory.
- Routes: Will clear all routes from memory.
- Reset default: Will reset the receiver by restoring all fac-

tory defaults.
- All: Will clear all memory.

(Clear All does not delete files but only waypoints, 
routes, track and user settings (language), as opposed 
to Delete All in File Manager which deletes all listed files 
but does not impact waypoints, track and routes; see 
page 44.)

After selecting the Clear Memory option from the Setup 
menu, tap the desired choice. The unit will ask you to con-
firm your choice. If you have selected All, the unit will 
then exit from the current application to return to the 
workspace screen. It will then automatically re-launch the 
same application for which re-initialization will be 
required (user language).



Simulate
This option allows you to set the simulator. It shows you how 
the unit uses its various functions based on a simulated jour-
ney. The simulator is useful for learning or demonstrating the 
unit’s GPS functions when indoors and there is no GPS recep-
tion. When the simulator is on, the unit quits normal operation 
to operate in the simulator mode. You can choose one of the 
following three options when you access the Simulate option:

- Off: Will turn the simulator off. The unit will return to 
normal operation

- Auto: Will turn the simulator on. A predefined heading 
and speed rate will be used.

- User: Will turn the simulator on. A user-defined head-
ing and speed rate will be used.

After selecting the Simulate option from the Setup menu, 
just tap the desired choice.
If you have selected User, the unit will then ask you to 
enter heading and speed data.

Language
This option allows you to select the language that the unit 
will use to display text.
TIP: If you accidentally set the language to one you cannot 
read and want to get back to the Language Select screen, 
follow these instructions. Press MENU. Tap the fifth item 
in the list and then tap the last item in the new list. You 
are back at the Language Select screen.
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The Map screen must be in 
Position mode if you wish 

to customize data fields. If 
the Map screen is in cursor 

mode (cursor is a cross-
hair), press ESC to return 

to the Position mode.

Available data:
BEARING

DISTANCE
SPEED

HEADING
VMG (Velocity made good)

CTS (Course to steer)
ETA (Estimated time of 

arrival)
ETE (Estimated time 

enroute
XTE (Crosstrack error)

Turn
Elevation

Time
Date

EPE (Estimated Positional 
Error)

Avg. Speed (Average 
speed)

Max Speed
Customize

Except for the Satellite Status screen, all navigation screens 
can be customized through the following procedure:
• Press NAV repeatedly until the desired navigation screen 

is displayed
• Press MENU
• Tap Customize. Additionally for the Map screen, tap Cus-

tomize Fields.
• On the Navigation screen now shown in edit mode, high-

light the data field to be changed using the left/right arrow 
and press ENTER

• Choose the data in the list that you wish now to display in 
this field. Press ENTER. Data change in the field is imme-
diate.

• Resume this procedure for all the fields that need to be 
changed on this screen and on the other navigation 
screens.

If you select Customize when the Map screen is displayed, an-
other option an additional menu is displayed showing two op-
tion:
- Customize Fields: This option is described above
- Street info: If you select this option, the bottom of the Map 

screen will display the name of the street you are currently 
walking or driving along. To re-activate the first option, 
press MENU, tap Customize and then Two Data Fields.

About...

The About... screen displays the current status of your unit.
Using the About... screen you can see the serial number of the 
receiver, the version of software, the version and memory size 
of the basemap and the memory space percentage occupied 
by data & maps, routes and waypoints.

Exit

This option allows you to quit the Mobile Mapping application 
that is currently running and return to the unit’s workspace 
screen.



6. Office Work

About Download Procedures

The easiest way to download field data collected with Mobile 
Mapping to your office computer is to remove the SD card 
from the MobileMapper CX and insert it into the card reader 
on your computer. This implies the following:
1. You are using the SD card, and not the MobileMapper CX 

internal memory, to store all your data (see setting on 
page 48).

2. Your computer should be equipped with an SD card 
reader.

If you do not have a card reader on your computer, then you 
should connect the MobileMapper CX to your computer via the 
USB cable provided and make sure the USB device switcher 
is set to “USB serial” (refer to the Receiver Description chap-
ter in the MobileMapper CX Getting Started Guide to set this 
port).
You can also use COM1 available on the I/O module (Serial 
data cable not provided).
In this chapter, it is assumed that Mobile Mapper Office has 
already been installed on your computer and the USB port on 

MobileMapper CX is set to operate as a serial USB port (and 

not as a USB port for ActiveSync).

Downloading GIS Data via USB

1. On MobileMapper CX:
- Clip the I/O module to the back of the MobileMapper 

CX.
- Connect the USB cable between the MobileMapper CX 

and your office computer.
- Turn on the receiver.

The first time you connect MobileMapper CX to the office 
computer, you may be asked to install a USB driver on the com-
puter (although this driver should normally have been installed 
when installing MobileMapper Office). This driver is located on 
the MobileMapper Office CD in the “.../USB Driver/PROMARK/” 
folder. Once you have inserted the CD in your CD drive, ask the 
computer to search for this driver on the installation CD and then 
follow the on-screen instructions to complete the driver installa-
tion.
If the USB connection fails, disconnect the USB cable and plug it 
back. Quit MobileMapper Transfer on the computer and restart it.
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Do not forget to double-tap 

the Mobile Mapping icon or 
else no communication will 

be possible between 

MobileMapper CX and the 
computer. 

Please connect the 
MobileMapper CX to the 
computer BEFORE run-

ning MobileMapper Trans-
fer.
- Make sure the USB device switcher ( >Settings> Con-
trol Panel) is set to “USB Serial”.

- Double-tap the Mobile Mapping icon.
- Make sure the MobileMapper CX Storage option setting 

will allow the MobileMapper Transfer utility to access 
the desired files. For example, if the files to be down-
loaded are on the SD Card, make sure SD Card is 
selected as the Storage option. To set this information, 
press the MENU key then select Setup then Storage.

2. On the office computer:
- From the Windows task bar, select Start>Pro-

grams>MobileMapper Office>MobileMapper Transfer. This 
launches MobileMapper Transfer.

(Double-click  in the right side of the window if 
you want to access the parent directory and open 
another folder on your office computer.)

- In the MobileMapper Transfer window, select File>Con-
nect>GPS Device via Cable. After a few seconds, the left 
side of the MobileMapper Transfer window lists the 
files stored in the MobileMapper CX.

- Select the MMJ files you want to download. If neces-
sary, hold down the Ctrl key to make a multiple selec-
tion.

- Press the F5 key. A Copying file dialog appears during 
data transfer.
IMPORTANT! For a job performed in post-processing 
mode, follow the same procedure (nothing more to be 
done). In fact, in this case, MobileMapper Transfer will 
also copy automatically the corresponding raw data file 
(a <job_name>.Rxx file) and split it into files usable by 
MobileMapper Office.

- Close the MobileMapper Transfer window.

3. On MobileMapper CX, quit the MobileMapping function, 
turn off the receiver and remove the cable between the 
office computer and MobileMapper CX.



Downloading GIS Data from the Card Reader

- Extract the SD card from the MobileMapper CX and insert 
it into your local SC card reader.

- From the Windows task bar, select Start>Pro-
grams>MobileMapper Office>MobileMapper Transfer. This 
launches MobileMapper Transfer.

- (Double-click  in the right side of the window if you 
want to change to the parent directory and open your job 
folder on the office computer.)

- In the MobileMapper Transfer window, select File>Con-
nect>PC drive. As a result, the left side of the window 
shows the file structure of your office computer.

- On top of the left side of the window, click on the down 
arrow and select the letter corresponding to your local SD 
card reader (for example “G:”). You can now see the field 
data files stored on the SD card.

- In the left side of the window, select the MMJ files you 
want to download. If necessary, hold down the Ctrl key to 
make a multiple selection.

- Press the F5 key or drag and drop the selected files from 
the left to the right side of the window. A Copying file dia-
log appears during data transfer.
IMPORTANT! For a job performed in post-processing 
mode, follow the same procedure (nothing more to be 
done). In fact, in this case, MobileMapper Transfer will 
also copy automatically the corresponding raw data file (a 
<job_name>.Rxx file) and split it into files usable by 
MobileMapper Office.

- Close the MobileMapping Transfer window once the down-
loading is complete.
61



62
Viewing/Analyzing the Content of a Job

Run MobileMapper Office and then use the File>Open com-
mand to open one of the MMJ files you have previously down-
loaded. As a result, MobileMapper Office shows the content of 
this job in the main window. Here is an example of a job open 
in MobileMapper Office:

NOTE: For a job performed in post-processing mode, please refer to 
the MobileMapper Office User Manual for more information.

First of all, you can see the list of layers present in this job in 
the lower-right corner of the screen. Clear or check the buttons 
for the layers you want to see in the Map Display area (the 
pane occupying the left part of the window).



The main purpose of viewing a job in MobileMapper Office is 
to get a view of the features that were logged during field op-
erations. If enabled for display, these features are represented 
on the Map Display area according to the viewing choices 
made for the corresponding layers. You can do more than just 
view these features. You can also view the conditions in which 
these features were logged. To do that, just click on these fea-
tures, one after the other in the Map Display area. This opens 
a new window in which you can see the properties of these fea-
tures. In the example below, MobileMapper Office shows the 
properties of the selected point being part of an area feature:
63



64
The Feature Properties window provides the following infor-
mation:
• Feature name and geometry, number of points for lines 

and areas only, measurement(s), user-settable Updated 
field. Apart from the Updated field, these are non-editable 
properties.
The nature of the measurements performed is presented 
below:

Length: MobileMapper Office determines the length of 
a line feature in the same way used by the receiver: by 
estimating the distance between successive points on 
the line feature with the assumption that each point is 
on a sphere of average Earth radius. The elevations of 
the points are not factored into the equation. Thus the 
software calculates the spherical distance rather than 
the horizontal or slope distance between the succes-
sive positions. The length of the line feature is the sum 
of all these distances..
Perimeter: MobileMapper Office estimates the perime-
ter of an area feature in the same way it estimates the 
length of line features.
Area of area features: MobileMapper Office determines 
areas by estimating the area enclosed within point 
locations recorded in the field with the assumption 
that each point making up the feature is on a sphere of 
average Earth radius. Thus the area is that of a curved, 
not flat, feature.

• Observation data (non-editable): date/time, duration of 
point logging.

• Current Position for the selected point (non-editable): lati-
tude, longitude, altitude, number of satellites used, PDOP 
and correction type.



Direction of 
travel along 
the feature

Feature offset to the 
left by distance d

d

“Real” feature
The correction type may be one of the following:
- “WAAS”
-  “RTCM”
-  “Post-processed”
-  “Uncorrected” (for autonomous positions)

• Accuracy Estimation for the selected point: horizontal 
error, vertical error (non-editable).

• Offset data (editable): direction (for line or area) or bear-
ing (for point), horizontal distance, vertical distance.
This set of properties can be used to artificially move the 
receiver’s GPS antenna by a certain distance from the real 
position it occupied in the field.
For example, if the receiver  was held at 5 feet (1.52 m) 
from the ground, you can enter “-1.52” m in the vertical 
distance cell to artificially bring the GPS antenna position 
down to ground level.
Likewise, you can offset a line or area feature to the right 
or left by a certain distance that you enter in the horizon-
tal distance cell. The Left and Right directions for the off-
set are defined with respect to the direction followed by 
the field operator along the feature while logging this fea-
ture (see example opposite).

• Attributes (editable): list of attributes and values currently 
assigned to these attributes. You can freely change these 
values or enter new ones if blank.

There are many other functions that you can use in Mo-
bileMapper Office such as creating feature libraries or back-
ground maps, importing/exporting GIS data, downloading 
reference station data, post-processing jobs, etc. Please refer 
to the MobileMapper Office User Manual for more informa-
tion.
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Exporting Data to a GIS

The most important processing of your field data is its export 
to a GIS. Exporting field data has two processes: conversion 
of the data files to a standard format a GIS can read and then 
the actual transfer of the file.
1. On your office computer, launch MobileMapper Office
2. From the menu bar, select File>Open
3. Select the folder where you downloaded your files. 
4. Select the MMJ file you want to open and then click Open. 

MobileMapper Office now views the data collected in the 
field.

5. From the menu bar, select File>Export.
6. Select one of the formats displayed and you will see a 

“Browse for Folder” window that allows you to select the 
directory to which the reformatted file will be transferred. 
If you don't know where to put this file, just select a tem-
porary location.

7. Click Export. Your job will be automatically formatted and 
transferred to the selected folder. You can select any 
folder that is accessible by your office computer - includ-
ing any GIS folders that may be on your network. When 
you start recording real data to export to a GIS, you will 
typically export data to a GIS database.



Uploading a Vector Background Map

Vector background maps are generated from DXF, SHP or MIF 
files imported in MobileMapper Office’s Map Editor.
Note that raster background maps CANNOT be uploaded to 
MobileMapper CX in its current version.
All or part of the background map attached to MobileMapper 
Office’s Map Display area can be uploaded.
The background map is output as an IMI file. The IMI file can 
be directly uploaded to the MobileMapper CX, or copied to the 
SD card inserted in the local SD card reader, or stored on the 
PC hard disk. In all cases, a connection to the MobileMapper 
CX is a prerequisite to the upload sequence.
Assuming the MobileMapper CX unit has been connected to 
the office computer via the USB1 or RS232 cable, it has been 
turned on, you have double-tapped the Mobile Mapping icon 
and you have selected the storage medium on which to upload 
the map, do the following on office computer side:
- Launch MobileMapper Office.

To attach the desired vector map to the Map Display area:

- Click 
- On the Vector Maps tab, select this map from the left-hand 

list and then click the Attach Map button.
- Click OK to close the window.

If you want to upload only a region of the background map:

- Click 
- Drag a rectangle around the desired region and then 

release the mouse button.
The limits of the region are now represented with a rectan-
gle. You can still resize or reshape the rectangle by drag-
ging its control points (corner and mid-side points). You 
can also move the whole rectangle by dragging the mouse 
cursor from inside the rectangle.

- When the location and size of the region is okay, click out-
side of this region.The region is now defined and its limits 
are represented by a thick green line.
NOTE: To delete the region and start over, resume the 
above three steps.

1. Make sure the USB device switcher ( >Settings>Control Panel) 
is set to “USB Serial”.
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Start the upload procedure as such by selecting File>Upload to 
GPS>Background Map. MobileMapper Office tests the connec-
tion to the MobileMapper CX (the software needs to know 
which type of receiver the map is intended for). Once the data 
link is established, you can make one of the following three 
choices:

• Upload to GPS Unit if you want to upload the map 
directly to the MobileMapper CX.

• Upload to SD Card Reader if you simply want to copy 
the background map to the SD card inserted in the 
local SD Card Reader (you will use that SD card later 
in a MobileMapper CX).

• Or Store on Hard Drive if you just want to create now 
the IMI file on your hard disk so that later you can 
copy it to an SD card using the local SD card reader.

1. If you select Upload to GPS Unit, then:
• Click Next >
• After the GPS unit has been detected on the USB or 

RS232 port, click Next > again.
• MobileMapper Office indicates the size of the map 

file and the remaining memory space on MobileMap-
per CX. Click Finish.

• If the map filename uses more than 8 characters, 
MobileMapper Office will  warn you that this name 
will be truncated. Keep the truncated name or type a 
different name and then click OK.

• Wait until the uploading messages on the office 
computer and MobileMapper CX disappear.

• When the upload procedure is complete, press 
MENU on the MobileMapper CX, tap Setup and then 
Select Map.

• Tap in the Detail Map field and then select the name 
of the file you have just uploaded

• Tap Save. MobileMapper CX starts loading the new 
map. After a while, the Map screen is displayed. 

• Use the IN, OUT and scrolling buttons to get a full 
view of the new map on the Map screen.



2. If you select Upload to SD Card Reader, then:
• Click Next >.
• Select the drive letter corresponding to the local SD 

card reader (e.g. “G:”)
• Click Next > again. MobileMapper Office indicates 

the size of the map vs. the remaining memory space 
on the SD card and the name of the background 
map file.

• Click Finish if you agree. The background map file is 
transferred to the SD card.

3. If you select Store on Hard Drive:
• Click Next >. MobileMapper Office indicates the size 

of the map vs. the remaining memory space on the 
hard disk, the folder where the file will be saved and 
the name of the background map file.

• Click Finish if you agree. The background map file is 
saved on the hard disk.
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To create a waypoint 

in a job:

Click on  in the 
MobileMapper Office tool-

bar and then click where to 
create the waypoint on the 

Map Display area. If neces-
sary, adjust its coordinates, 

icon and name in the edit 
box on the right.

For more detail, please 
refer to the Using the Way-
point/Route Editor Chapter 
in the MobileMapper Office 

User Manual.
Uploading Jobs and Waypoints

Jobs and waypoints associated with jobs are uploaded through 
the same procedure.
The way waypoints are uploaded and made available on the 
MobileMapper CX depends on whether the uploaded job is 
“empty” (i.e. there is no GIS data in it, just waypoints) or not:
- If the job is “empty”, the uploaded waypoints will replace 

the list of existing waypoints stored in the MobileMapper 
CX. Prior to uploading, a message will warn you that the 
waypoints currently stored in MobileMapper CX will be 
deleted.

- If the job is not “empty” (i.e. it contains GIS data), way-
points are uploaded as a separate MMW file associated 
with the MMJ job file. On MobileMapper CX, these way-
points will be visible only when you open the correspond-
ing job. These waypoints will add up to the list of existing 
waypoints.

Assuming the MobileMapper CX unit is connected to the of-
fice computer via the USB1 or RS232 cable, it has been 
turned on and you have double-tapped the Mobile Mapping 
icon, do the following on office computer side:
- Launch MobileMapper Office.
- Open the MMJ job file you want to upload

- Click  to read the list of waypoints associated with the 
job. If you change the list, save the job before continuing.

- Select File>Upload to GPS>Job.
• If the job is “empty”, a message will warn you that all 

waypoints currently stored in the MobileMapper CX 
will be lost if you continue. Click Yes if  you agree and 
then wait until the upload procedure is complete.

• If the job is not “empty”, MobileMapper Office will 
successively upload the MMJ file and then the MMW 
file.

1. Make sure the USB device switcher ( >Settings>Control Panel) 
is set to “USB Serial”.



Uploading Jobs and Waypoints to the Local 

SD Card Reader

If you are using the SD card in the field rather than the Mo-
bileMapper CX’s internal memory, you can also copy your MMJ 
and MMW files to the SD card using the MobileMapper Trans-
fer utility and your local SD card reader.
- Extract the SD card from the MobileMapper CX and insert 

it into your local SC card reader.
- From the Windows task bar, select Start>Pro-

grams>MobileMapper Office>MobileMapper Transfer.

- (Double-click  in the right side of the window to 
access the folder containing the MMJ and MMW files you 
want to upload.)

- In the MobileMapper Transfer window, select File>Con-
nect>PC drive. As a result, the left side of the window 
shows the file structure of your office computer.

- On top of the left side of the window, click on the down 
arrow and select the letter corresponding to your local SD 
card reader (for example “G:”). You can now see the field 
data files stored on the SD card.

- In the right side of the window, select the MMJ and MMW 
files you want to upload. If necessary, hold down the Ctrl 
key to make a multiple selection.

- Press the F5 key or drag and drop the selected files from 
the right to the left side of the window. A Copying file dia-
log appears during data transfer.

- Close the MobileMapper Transfer window once the upload-
ing is complete.
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7. Appendices

Naming Conventions for Rover 
and Reference Files (Post-Processing Option)

Suppose you have created a new job named “JOB1.MMJ.” 
You selected the post-processing job mode in MobileMapper 
CX so that it records GPS measurement files in addition to 
JOB1.MMJ. The table below illustrates how these files will ap-
pear at various stages of the differential correction process:

Suppose you have logged a reference station file on Mo-
bileMapper CX. The table below illustrates how the resulting 
files will appear at various stages of the differential correction 
process:

The rover files with a B, D or E in the extension represent files 
with different GPS measurements all related to the original 
rover file. MobileMapper Office handles the information in 
these files automatically. But if you archive your files, you 
should include them in the archived directories.
The reference files that start with B, D or E are similarly han-
dled automatically by MobileMapper Office but should be ar-
chived together with the rover files.
Reference files recorded by non-MobileMapper CX receivers 
may have other naming conventions.

Rover file seen on receiver JOB1.MMJ
Rover file seen on MobileMapper Transfer’s left 
window, before download JOB1.MMJ

Rover file seen on MobileMapper Transfer’s right 
window, after download JOB1.MMJ

Rover files seen with Windows Explorer, after 
download

JOB1.MMJ, JOB1.B00, 
JOB1.D00 and JOB1.E00

Rover file seen on MobileMapper Office’s Differ-
ential Correction window JOB1

Reference file seen on receiver Not Seen

Reference file seen on MobileMapper 
Transfer’s left window, before download

0001a04.034 (for the first file 
recorded at reference station site 
ID 0001 on the 34th day of 2004

Reference file seen on MobileMapper 
Transfer’s right window, after download

b0001a04.34, d0001a04.34 and 
e0001a04.34

Reference files seen with Windows 
Explorer, after download

b0001a04.34, d0001a04.34 and 
e0001a04.34

Reference file seen on MobileMapper 
Office’s Differential Correction window b0001a04.34



Mobile Mapping allows 
you to define the full 
set of 9 parameters 

defining a map datum. 
After pressing MENU 

and selecting 
Setup>Map 

Datum>Primary/Sec-
ondary and “USER” in 
the prompted list, you 
now have access to two 

different screens on 
which these 9 parame-

ters are presented:
1st screen:

Delta A (meters)
Delta F (X 10,000)
Delta X (meters)
Delta Y (meters)
Delta Z (meters).

2nd screen (select 
Next> at the bottom of 
the 1st screen to 
access this screen):

Rotation X (sec)
Rotation Y (sec)
Rotation Z (sec)
Scale factor (ppm).
Defining a User Map Datum

Whether you are in the office using MobileMapper Office, or 
in the field working with your receiver, the system lets you cre-
ate the user map datum you need.
However you will not use the same methods with mobile Map-
ping (in the receiver) and in MobileMaper Office to define the 
semi-major axis and flattening for your user datum.
In MobileMapper Office, you will use the conventional way of 
defining a user datum, i.e. by entering the semi-major axis (a), 
the inverse flattening (1/f) and the other 7 parameters.
The method used in the receiver with Mobile Mapping is dif-
ferent as it is based on the use of parameters ∆a (Delta A)and 
∆f (Delta F) –known as the Molodensky parameters– instead 
of a and 1/f. The other 7 seven parameters are exactly the 
same as those in MobileMapper Office.
∆a and ∆f are defined as follows:

∆a (m) = a(WGS 84) - a(Local Datum)
∆f = f(WGS 84) - f(Local Datum)

Note that the flattening (f), instead of the inverse flattening 
(1/f), is used in the expression of ∆f. So we have:

Because the resulting ∆f is a very small quantity, it is multi-
plied by 10 000 to make it easier to handle. (The resulting 
value is closer to 1.) It is this value that you have to enter in 
the Delta F field in Mobile Mapping.

∆f 1
1
f
--- WGS84( )
--------------------------- 1

1
f
--- Local( )
-----------------------–=
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Calculation example:

∆a and ∆f of Frequently Used Datums

WGS 84 Local 
Datum

a 6 378 137 6 378 388
1/f 298.257 223 563 297

Complete the fields below on 
the receiver screen using the 
values of ∆a and 10000x∆f, be-
low, left):

∆a - 251 m Delta A (meters)
fWGS 84 3.352 810 665 x 10-3

fLocal 3.367 003 367 x 10-3

∆f -- 0.014 192 702 x 10-3

10 000 x ∆f - 0.141 927 02 Delta F (X10,000)

Name a 1/f Da Df x 10 000
Airy 6377563.396 299.3249646 573.604 0.11960023
Australian National 6378160.0 298.25 -23.0 -0.00081204
Bessel 1841 6377397.155 299.1528128 739.845 0.10037483
Bessel 1841 (Nambia) 6377483.865 299.1528128 653.135 0.10037483
Clarke 1866 6378206.4 294.9786982 -69.4 -0.37264639
Clarke 1880 6378249.145 293.465 -112.145 -0.54750714
Everest 6377276.345 300.8017 860.655 0.28361368
Fischer 1960 (Mercury) 6378166.0 298.3 -29.0 0.00480795
Fischer 1968 6378150.0 298.3 -13.0 0.00480795
GRS 1967 6378160.0 298.247167427 -23.0 -0.00113048
GRS 1980 6378137.0 298.257222101 0.0 -0.00000016
Helmert 1906 6378200.0 298.3 -63.0 0.00480795
Hough 6378270.0 297.0 -133.0 -0.14192702
International 6378388.0 297.0 -251.0 -0.14192702
Krassovsky 6378245.0 298.3 -108.0 0.00480795
Modified Airy 6377340.189 299.3249646 796.811 0.11960023
Modified Everest 6377304.063 300.8017 832.937 0.28361368
Modified Fischer 1960 6378155.0 298.3 -18.0 0.00480795
South American 1969 6378160.0 298.25 -23.0 -0.00081204
WGS 60 6378165.0 298.3 -28.0 0.00480795
WGS 66 6378145.0 298.25 -8.0 -0.00081204
WGS 72 6378135.0 298.26 2.0 0.0003121057
WGS 84 6378137.0 298.257223563 0.0 0.0



Glossary

Attribute: A description item of a feature.
Attribute value: One of the possible values that can be as-
cribed to a feature.
Base Station: See Reference Station.
B-File: A binary file containing GPS measurement data.
Carrier phase data: Phase angle measurements for the 1575 
MHz radio wave carrying the GPS coded messages. Using car-
rier phase data greatly improves GPS accuracy.
Datum: A mathematical definition of a surface from which co-
ordinates of a given system are referenced.
D-File: A binary data file created by field collection software 
and stored in the receiver.
DGPS: Differential Global Positioning System. Commonly 
used to refer to real-time differential correction techniques.
Differential Correction: The process of:
(1) calculating how much to adjust GPS measurements to re-
duce the difference between a location's surveyed coordinates 
and the coordinates calculated by a GPS receiver that is kept 
stationary over that point; and
(2) the application of these adjustments to the GPS measure-
ments recorded by any number of receivers within a few hun-
dred kilometers of the "reference receiver."
Differential GPS: See DGPS.
E-File: A binary file containing GPS ephemeris data.
Ephemeris Data: Information transmitted from a satellite 
which allows the GPS receiver to determine the satellite’s po-
sition in space.
Export: Converting data files to GIS Formats and writing them 
to any directory visible to the PC.
Feature: Any element located in the field that you wish to 
record for further uploading into a GIS database for example. 
A feature can represent a real object (streetlight, park, electri-
cal transformer, etc.) or on the contrary, something invisible or 
impalpable (gas, noise level, dose of fertilizer, etc.).
Each new feature that you log in the field can only be an “em-
anation” or “offshoot” of one of the feature types described in 
the feature type library associated with the job in progress. 
The logging procedure will be different depending on the type 
of the feature you are logging.
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To log a feature: Means to save the characteristics of a 
feature into memory. The user is in charge of entering the 
description of this feature whereas the receiver is respon-
sible for saving the GPS position(s) it has determined on 
this feature.
To describe a feature: Means to give each attribute of the 
feature one of the prompted values for this feature.

Feature Library: A file containing all the feature types required 
for a given job. (In fact we should say “Feature Type Library”.)
Feature Type: An item present in a feature library. Each fea-
ture type is defined by a geometry type, a name, a certain 
number of possible attributes and the list of possible values 
for each attribute. There are four different geometries in fea-
ture types: point, line, area and grid.
Field: Any area on the receiver screen dedicated to displaying 
the value of a parameter. Some fields are user-editable, some 
others are not.
Geographic Information System: A system of digital maps, 
data analysis software and a database of features, attributes 
and geographic locations.
GIS: See Geographic Information System.
Global Positioning System: A system of satellites providing 
worldwide coverage for positioning information. Although in-
stalled and maintained by the United States, the broadcast 
signals are available to anyone anywhere in the world.
GPS: See Global Positioning System
GPS satellite geometry: The satellite distribution at a given lo-
cation. measured by the PDOP index
GPS signal multipath: Occurs when the GPS signal arrives at 
the antenna by a path other than a straight line. Multipath sig-
nals make the receiver think that a GPS satellite is farther 
away than it is and the resultant position is inaccurate.
Job file: File containing a feature type library and a collection 
of features that grows as you log new features in the field with 
this job file open. All the features in the job file necessarily 
“originate” from the feature types present in the job file’s fea-
ture type library.
Nesting: This word is used to describe a feature that you are 
logging whereas another feature is already being logged.
PDOP: Positional Dilution of Precision. An accuracy factor de-
rived from the geometry of the constellation of GPS satellites 
used to calculate a position. In general, the more widely dis-
tributed the satellites are in the sky, the greater the accuracy. 
In general, PDOPs less than 10 are good.



Post-processing: Differential corrections applied to GPS posi-
tions in a PC - after both rover and reference data are logged 
and downloaded. Post-processing is slower but more accurate 
than real-time differential correction.
RTCM: Radio Technical Commission for Maritime Services. 
Commonly refers to a format of real-time DGPS format.
Reference Station: A stationary GPS receiver logging, or broad-
casting, data from a known point. The data is used for differ-
ential correction. Reference Station is synonomous with Base 
Station.
RINEX: Receiver Independent Exchange Format. A “univer-
sal” GPS measurement data format designed to allow compat-
ibility b tween different brands of GPS receivers.
Shapefile: A set of GIS files invented by ESRI but published 
as an open file standard readable by most GISs. A shapefile 
consists of a map file (SHP), a file containg feature descrip-
tions (DBF), a file relating the map locations with the feature 
description (SHX) and sometimes a file containing coordinate 
system information (PRJ).
Waypoint: A pre-determined coordinate point to which a GPS 
receiver can navigate. GPS receivers can also log waypoints in 
the field for later navigation. GPS for GIS receiver have largely 
replaced waypoints with point features.
WGS-84 coordinate system: World Geodetic System, 1984. 
The coordinate system is used by GPS receivers for computing 
their positions.
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Index
- sign  44
Symbols
+ sign  44
Numerics
3D/2D  24
A
Activation code (post-processing)  25
ActiveSync  1
Alarm, Arrival  54
Alarm, PDOP  55
Alphabetical  36
Area measurement  64
Averaging  32
B
Backtrack  42
Basemap  48
Bearing, offset  14
Beeper  56
C
CD (companion CD)  1
Clear, memory  56
Columns, grid feature  18
Compass  33
Compass screen  30
Coordinate systems  51
Cursor mode (map screen)  29
Customize  58
Customize Fields  58
D
Data screen  33
Depart-Dest Line  50
Detail  49
Detail map  48
DGPS  32
Direction, line or area feature offset
15
E
Export  66
F
Feature Properties window  63
Files, managing  45
G
GOTO  35,  39,  40

H
Heading, grid feature  18
Horizontal Distance, offset  14
I
I/O module  1
IMI  45,  67,  68
J
Job content  62
L
Languages  57
Large Data screen  30
Leg  43
Length measurement  64
M
Map datum  52
Map screen  29
Mark  44,  45
Mini-USB port  1
MMJ  66
Multi-leg  41
N
Nav screens  51
Nearest To  36
North reference  55
Number of tracked satellites  24
O
Offset  65
Orientation  49
P
PDOP  24
Perimeter measurement  64
Pos-Dest Line  50
Position screens  31
Post-processing  25
Primary Usage  50
Product key  1
R
Reference station  27
Reset Trip  56
Reverse  43
Road  33
Road screen  33
Routes  47
Rows, grid feature  18
RS232  67,  68,  70
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Satellite Status screen  34
Scale indicator  33
SD Card Utilities  58
Setup  48
Setup menu  44
Show Map Info  50
Simulate  57
Simulator  57
Spacing, grid feature  18
Speedometer screen  34
Storage  48
Storage option  60
Store on Hard Drive  68
Street info  58
T
Target on Map screen  22
Time format  53
Track history  56
Track Lines  50
Track Mode  49
Two Data Fields  58
U
Units  54
Unlock (Mobile Mapping)  2
Upload to SD Card Reader  68
USB device switcher  59
USB driver installation  59
USB serial  59
User map datum  53
V
Vertical Distance, offset  14
W
Waypoints  50,  70,  71
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Reference Manual

Magellan
Mobile Mapping Solutions Contact Information:
In USA +1 408 572 1100 � Fax +1 408 572 1199
Toll Free (Sales in USA/Canada) 1 800 922 2401
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In Singapore +65 9838 4229 � Fax +65 6777 9881
In China +86 10 6566 9866 � Fax +86 10 6566 0246
Email mobilemappingapac@magellangps.com

In France +33 2 28 09 38 00 � Fax +33 2 28 09 39 39
In Russia +7 495 980 5400 � Fax +7 495 981 4840
In the Netherlands +31 78 61 57 988 � Fax +31 78 61 52 027
Email mobilemappingemea@magellangps.com
www.pro.magellangps.com

Magellan follows a policy of continuous product improvement; specifications and descriptions are thus subject to change without notice. Please contact Magellan for the latest product information.
©2007-2009 Magellan Navigation, Inc. All rights reserved. MobileMapper is a trademark of Magellan Navigation, Inc. All other product and brand names are trademarks of their respective holders.
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